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This manual is a reference guide to the BaseStation application for
the SBS-3. It can also be used with the 1090 Puck, SDR Puck,
SBS-1eR, SBS-1e and SBS-1.
BaseStation is a Windows application written originally for the SBS-1
family of Virtual Radar Receivers. The latest version (1.2.4.183) of
BaseStation has been updated for the SBS-3 and the Puck but may
also be used with the SBS-1eR, SBS-1e and the classic SBS-1,
although not all features will apply. Features that do not apply to all
products are marked in this manual with the symbols SBS-3,

SBS-1eR , SBS-1e, SBS-1, 1090 Puck and SDR Puck as
appropriate.
Please note that it may also be necessary to upgrade the firmware
when upgrading to the latest version of BaseStation.

1.2

Document Conventions

!

A paragraph with this symbol contains a handy tip that will help you
use the product more efficiently.

"

A paragraph with this symbol contains an important point that you
need to understand.

#

A paragraph with this symbol warns you about possible problems you
might encounter.

1.3

Product Descriptions
The SBS-3 is a Virtual Radar Receiver with two built-in Software
Defined Radio (SDR) tuners allowing up to six VHF or UHF radio
channels to be monitored simultaneously, for voice or data. It can be
connected to a PC or network using USB or Ethernet.
The 1090 Puck is a compact, lightweight Virtual Radar Receiver with
similar performance to the SBS-3 but without the SDR tuners and
connects to a PC using USB only.
The SDR Puck is a compact, lightweight Software Defined Radio
(SDR) tuner allowing up to six VHF or UHF radio channels to be
monitored simultaneously, for voice or data.
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Further Information
A useful source of further information can
be found at the SBS Forum:
www.kinetic.co.uk/forums
Accessories may be purchased from:
www.taylormaderf.co.uk
Software and firmware updates are
available at:
http://www.kinetic.co.uk/basestationdownloads1.php
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2

Getting Started

2.1

Connecting using USB (except SDR Puck)
The simplest way to get started with your 1090 Puck, SBS-3,
SBS-1eR, SBS-1e or SBS-1 is to connect it to your PC using a USB
cable, attach the 1090 MHz antenna, and install the BaseStation
software following the procedure described in the Getting Started
notes that accompany the BaseStation CD-ROM.
Running the BaseStation installer will also automatically install the
FTDI USB driver that BaseStation needs to communicate to the 1090
Puck, SBS-3, SBS-1eR, SBS-1e or SBS-1 using USB. When the install
process is complete, run the BaseStation application. The first time
that you run BaseStation it will ask you to input your home location
and will check that data is received correctly from the SBS unit.
The BaseStation Software Reference section of this manual describes
how to view aircraft on a Virtual Radar Display.

!

The SBS-3 may require over 1000 mA of current from the USB port
when both SDR tuners are turned on. Some PC’s, particularly older
ones may not be able to supply this amount of power on a USB port.
In this case, a special Y cable may be used to connect to either a
second USB port on the PC, or an external power supply. One arm of
the Y cable carries power only, and the other carries both power and
data.
When receiving 1090 MHz radar data only, the SBS-3 uses less power
and can be powered from any USB port.

2.2

Connecting an SDR Puck using USB
Connect your SDR Puck to your PC using a USB cable, and install the
BaseStation software following the procedure described in the Getting
Started notes that accompany the BaseStation CD-ROM.
With an SDR Puck, Basestation is typically used without the main
(radar display) window, which may be hidden using the
Settings>Hide Main Window menu option. Selecting this option
makes the SDR Control Panel the main window of the application,
with a limited set of menu items.
Please refer to section 4.1 of this manual for instructions on using the
SDR Control Panel.
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Connecting using Ethernet
Connecting via Ethernet requires more configuration but can offer
greater flexibility, for example allowing connection over long
distances.
You can connect using Ethernet if you have an SBS-3, SBS-1eR,
SBS-1e or an SBS-1EM add-on Ethernet module for your SBS-1.
To change between USB and Ethernet connection, use the SettingsData Source menu item and select the required type of connection.
You may also need to use the Network tab of the Settings-Hardware
Settings menu item to adjust the IP address that BaseStation
connects to, if the address of the SBS unit has been changed from
the default of 192.168.1.170.
Information on changing the IP address of an SBS-1 family device is
available on the SBS forum. See the notes below for the SBS-3.

2.3.1

Connecting the

SBS-3 using Ethernet

You will need to refer to the section of this manual on Configuring
SBS-3 Ethernet Settings.
When connecting via Ethernet you can also use the SBS-3 as a stand
alone data server. A remote device can open a TCP socket connection
to the SBS-3’s main port and receive data without the requirement to
log in or run BaseStation. More information is provided in the section
on Stand-Alone Operation of the SBS-3.
The SBS-3 always needs to be powered using the USB socket. If you
are going to connect via Ethernet rather than USB, you will need to
attach an external USB power supply. It is recommended that the
external supply is rated at 2.0 Amp (2000 mA) or greater. When the
USB port on the SBS-3 is connected to a PC (and the orange USB
light is on indicating a USB data connection), the Ethernet interface
on the SBS-3 is automatically turned off to save power. Therefore you
cannot connect using Ethernet if the SBS-3 is connected via a USB
cable to a PC.
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SBS-3 Front Panel LED Indicators Description

LED INDICATORS (viewed from the front – running left to right)
Power

USB OK

Session
Active

Indicates USB port is Indicates that
SBS-3 is connected BaseStation
powered
and
or other
enumerated application is
connected
Red

Orange

Green

!

!

!

NVRAM Auxilliary Ethernet Tri-Colour
Update

Signal 1 to 4

The
Reserved BaseStation Reserved Bar graph of aircraft
SBS-3 is for future or other for future activity. Left to Right
updating
use
application
use
Orientation.
its nonis
volatile
connected
memory
via Ethernet
Orange
Red
Yellow TriColour Blue Blue Blue Blue

© 2005-2013 Kinetic Avionics Limited.

!

!

!

!

!

!

!

!

This document is subject to the terms of the included EULA.

BaseStation Reference Manual

2.5

Page 10 / 108

SBS-3 Rear Panel Connections

From left to right, the connections at the rear of the SBS-3 are:
1090 MHz Antenna. Used to connect the supplied magnetic mount
antenna or other 1090 MHz antenna for receiving aircraft radar
signals.
SDR antenna connection. Used for connecting an antenna for the
two built-in SDR receivers.
Audio out. A 3.5 mm stereo audio jack socket for use with external
speakers or headphones. It may also be connected to the audio line
input of a PC or sound card.
Ethernet. Used to connect the SBS-3 to a PC or network.
USB. Can be used to connect the SBS-3 to a PC or to power the
SBS-3 from an external power adapter.
Aux Connector. An I2C bus and RS-232 connector for use with
future accessories.
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1090 Puck, SDR Puck Front LED Indicators
LED INDICATORS (viewed from the front – running left to right)
Power

USB OK

Session
Active

Aux

Signal 1 to 4

Indicates USB port is Indicates that Reserved Bar graph of aircraft or
unit is
connected BaseStation for future SDR activity. Left to
powered
and
or other
use
Right Orientation.
enumerated application is
connected
Red
Orange
Green
White Blue Blue Blue Blue
!

2.7

!

!

!

!

!

!

!

1090 Puck, SDR Puck Rear Connections
Antenna. On the 1090 Puck, used to connect the supplied magnetic
mount antenna or other 1090 MHz antenna for receiving aircraft
radar signals. On the SDR Puck, used for connecting an antenna for
the SDR receiver.
USB. Used to connect the Puck to a PC.
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SBS-1eR, SBS-1e Front Panel LED Indicators

LED INDICATORS (viewed from the front – running left to right)
Power

USB OK

Session
Active

Indicates USB port is Indicates that
unit is
connected BaseStation
powered
and
or other
enumerated application is
connected
Red

Orange

Green

!

!

!

2.9

NVRAM Reserved
Update

Ethernet

Reserved

Signal 1 to 4

The SBS Reserved BaseStation Reserved Bar graph of aircraft
unit is for future or other for future activity. Left to Right
updating
use
application
use
Orientation.
its nonis
volatile
connected
memory
via Ethernet
Orange
Red
Yellow TriColour Blue Blue Blue Blue
!

!

!

!

!

!

!

!

SBS-1 Front Panel LED Indicators
LED INDICATORS (viewed from the front – running left to right)

Power

USB OK

Session
Active

Indicates USB port is Indicates that
unit is
connected BaseStation
powered
and
or other
enumerated application is
connected
Red

Orange

Green

!

!

!

NVRAM Reserved Reserved
Update

Signal 1 to 4

The SBS Reserved Reserved Bar graph of aircraft
unit is for future for future activity. Left to Right
updating
use
use
Orientation.
its nonvolatile
memory
Orange
Red
Yellow Blue Blue Blue Blue
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2.10 SBS-1eR Rear Panel Connections

From left to right, the connections at the rear of the SBS-1eR are:
1090 MHz Antenna. Used to connect the supplied magnetic mount
antenna or other 1090 MHz antenna for receiving aircraft radar
signals.
Radio Antenna connection. Used for connecting an antenna for the
built-in air band AM / broadcast FM radio receiver.
Audio out. A 3.5 mm stereo audio jack socket for use with external
speakers or headphones. It may also be connected to the audio line
input of a PC or sound card.
Ethernet. Used to connect the SBS-1eR to a PC using a network.
USB. Used to connect the SBS-1eR to a PC.
Power Switch. Controls whether the SBS-1eR is powered from USB
or the external power input.
External DC Power Input. 9 to 28V DC (centre pin is +ve).
External Radio Interface. An RS-232 connector for controlling an
external radio.
© 2005-2013 Kinetic Avionics Limited.
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2.11 SBS-1e Rear Panel Connections
From left to right, the connections at the rear of the SBS-1e are:
1090 MHz Antenna. Used to connect the supplied magnetic mount
antenna or other 1090 MHz antenna for receiving aircraft radar
signals.
Ethernet. Used to connect the SBS-1e to a PC using a network.
Ethernet Power Switch. Controls whether the Ethernet port is
powered. The Ethernet port can be switched off when connecting via
USB, to save power.
USB. Used to connect the SBS-1e to a PC.
Power Switch. Controls whether the SBS-1e is powered from USB or
the external power input.
External DC Power Input. 9 to 18V DC (centre pin is +ve).
External Radio Interface. An RS-232 connector for controlling an
external radio.

2.12 SBS-1 Rear Panel Connections
1090 MHz Antenna. Used to connect the supplied magnetic mount
antenna or other 1090 MHz antenna for receiving aircraft radar
signals.
USB. Used to connect the SBS-1 to a PC.
Power Switch. Controls whether the SBS-1 is powered from USB or
the external power input.
External DC Power Input. Voltage depends on the particular
revision of SBS-1 (centre pin is +ve).
External Radio Interface. An RS-232 connector for controlling an
external radio.

© 2005-2013 Kinetic Avionics Limited.

This document is subject to the terms of the included EULA.

BaseStation Reference Manual

Page 15 / 108

3

BaseStation Software Reference

3.1

Screen Layout
The main screen of the application looks something like this:

Figure 1: Application main screen

On the left is the Radar Screen and on the right is the Aircraft List. In
between them is a splitter control – which you can drag in and out
with the mouse to change the width of the Aircraft List.
At the top is the toolbar, which contains shortcut buttons to activate
the most frequently used menu items.
Along the right-hand side is the sidebar, which contains shortcut
buttons to some menu items related to the radar view. The sidebar is
the only part of the user interface that remains visible when in full
screen mode.
You can also toggle between a normal and expanded Aircraft List by
clicking on the Aircraft List Expand button (the button with a green
triangle and the caption Open).
!

You can also use the keyboard shortcut Ctrl-E
The picture below shows the screen after the Aircraft List has been
expanded:
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Figure 2: Application main screen with aircraft list expanded

To return the Aircraft List to the normal width, simply click once again
on the Aircraft List Expand button (the caption on the button will have
changed to Close).
!

Keyboard shortcut Ctrl-E
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The “Radar” Screen
The radar screen looks something like this:

Figure 3: Radar Screen

The above example shows the screen centred on the Gatwick
waypoint with a diameter of 50 nautical miles. Five aircraft can be
seen on the screen, one of which, 4690C1, is shown as a red box to
indicate that it is selected. Since the Display Bearing & Distance
option has been enabled for this radar screen, a red line displays the
bearing (100 °) and range (23.3 nautical miles) of that aircraft from
the centre of the view (Gatwick).
The aircraft, and the trails indicating their past positions, are colour
coded to indicate whether they are climbing, descending, or flying
level. By default, these colours are:

© 2005-2013 Kinetic Avionics Limited.
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(The way to remember it is that ascending aircraft are flying towards
blue sky, descending aircraft are flying towards brown earth, and
aircraft flying straight and level are somewhere in between – hence
the blue-green colour).
In our example, 400C47 (top of the screen) has been steadily
climbing, 4CA12A (top middle of the screen) was flying straight and
level when it entered the screen but is now descending, and 4CA264
(left middle of the screen) was descending when it entered the
screen, but is now flying straight and level.
There are two other colours that aircraft can be shown as:

Aircraft that are currently on the ground are shown as grey. If
BaseStation does not receive a signal from an aircraft for a set period
of time (by default, this is 30 seconds), the colour of that aircraft is
changed to yellow. If nothing is received for a further 5 seconds, then
the aircraft is removed from the screen.
!

These colours and times can be configured using the Settings >
Display Settings menu and the Settings > Data Settings menu
respectively.
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Main Menu
This section of the manual describes the function of each menu item
available from the application’s main menu bar.

!

Many of these functions are also available via toolbar buttons and/or
shortcut keys.

3.3.1

File Menu

3.3.1.1

Start Recording
This menu option brings up a box that prompts you for the name of a
file to save received data to. The default file name will be yyyymmddhhmmss.bst, where yyyymmdd and hhmmss represent the date and
time. Once you click on Save, all received aircraft transponder
messages will be saved to the file.

!
3.3.1.2

Toolbar button

Keyboard shortcut Ctrl-R

Play Previous Recording
This menu option brings up a file selection dialog box that allows you
to select a .bst file that you previously recorded a session to. The
application will then “play” the data in that file, displaying it instead of
the data being received from the SBS or Puck device.

!
3.3.1.3

Toolbar button
Stop Recording/Playing
This menu option is enabled only if you are either recording or
playing a session. It stops the recording or playing that is in progress.

!
3.3.1.4

Toolbar button
Pause Playing
This menu option is enabled only if you are currently playing a
session. It pauses the playing.

!
3.3.1.5

Toolbar button
Print
This menu item has two sub-menu options.
• Print Radar Screen: Prints the currently selected radar screen. If
there is only one radar screen currently visible then that is the one
that will be printed. If you have split the screen into two then the
one that is highlighted by a red box around it will be printed.
• Print Aircraft List: Prints the Aircraft List (the grid of data on the
right-hand side of the screen).
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Exit
This menu option shuts down the application.

!

By default BaseStation displays an box asking “Do you really want to
shut BaseStation down?” each time you close the application. You can
turn this prompt off using the Confirm on Close checkbox on the
Display Settings tab of the Setttings > Display Settings menu.

3.3.2

Edit Menu

3.3.2.1

Copy Radar Screen
This menu option copies the currently selected radar screen to the
Windows clipboard as a bitmap image that can then be pasted into
standard Windows graphical applications.

!
3.3.2.2

The radar screen can also be copied by pressing Ctrl-C.
Copy Aircraft List
This menu option copies the data in the aircraft list to the Windows
clipboard in a tab delimited text form. It can then be pasted into
standard word processors or spreadsheets.

!

3.3.3
!
3.3.3.1

The aircraft list can also be copied by pressing Ctrl-L.

Radar Menu
Most items on this menu can also be accessed via a pop-up menu by
right-clicking on a radar screen.
Zoom In
This menu option increases the “magnification” of the view on the
selected radar screen, so that it shows a smaller area but in greater
detail.

!
3.3.3.2

Toolbar button

Keyboard shortcut CTRL-I.

Zoom Out
This menu option is the opposite of Zoom In.

!
3.3.3.3

Toolbar button

Keyboard shortcut CTRL-O.

Reset
This resets the view (i.e. screen centre, zoom, and view toggles) to
the default for that view.

!
3.3.3.4

Toolbar button
Pan Screen
The four Pan Screen sub-menu options allow you to shift the centre
point of the view, up, down, left and right.
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You can also pan using the “arrow” buttons on the toolbar or by
pressing Ctrl-Alt-U for up, Ctrl-Alt-D for down, Ctrl-Alt-L for left or
Ctrl-Alt-R for right.
Save Radar Screen View
This menu option allows you to save the settings of the currently
selected radar screen under a name specified by yourself. Clicking on
this menu option brings up the following prompt, showing the name
of the saved view currently assigned to the selected radar screen.
Every radar screen has a saved view associated with it. If you have
not created any saved views then the screen will be associated with a
view called Default.

Figure 4: Save View dialog box

To update the named saved view with the current settings of the
radar screen, simply click on OK. To save the current settings to a
new saved view – and associate the radar screen with that new saved
view – simply type in the name of the new view and then click on OK.
The following attributes are recorded in a saved view:
• The view centre.
• The zoom diameter.
• Whether Show All Trails is enabled.
• Whether Show Only Recent Trails is enabled.
• Whether Show Bearing & Distance is enabled.
• Whether Show Waypoints is enabled.
• Whether Show Range Rings is enabled.
• Whether Show Outlines is enabled.
• Whether Display Selected Only is enabled.
• Whether Display Interested Only is enabled.
• Whether the screen stays centred, tracks an aircraft, or tracks the
coordinates given by an attached GPS unit.
© 2005-2013 Kinetic Avionics Limited.
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"

It is important to understand that a view is only updated if you click
on Save Radar Screen View. If you select a saved view for a radar
screen and then for example zoom in, the saved view will still be set
to the previous value. If you then shut down the application and
rerun it, the application will start up with the radar screen restored to
that saved view, with the zoom diameter as saved in the saved view
(i.e. as it was before you zoomed in). BaseStation is designed this
way so that you can create a set of standard views for yourself and
then zoom and pan around without fear that you will inadvertently
“overwrite” your saved views.

!

Toolbar button

3.3.3.6

Add Radar Screen Tab
This menu items creates an additional radar screen tab, so that you
can have two or more radar screens active and switch between them
simply by clicking on the tabs that appear at the bottom of the
screen. Each tab shows the name of the saved view that is currently
assigned to the radar screen on that tab.

Figure 5: Radar Screen tabs

!

Toolbar button

!

You can switch between tabs from the keyboard by pressing Ctrl + Alt
+ [Tab Number]. In the example shown in the above screenshot, you
could switch to the Gatwick tab by selecting Ctrl + Alt + 1.

3.3.3.7

Keyboard shortcut Ctrl-A.

Remove Radar Screen Tab
This menu option removes the currently selected tab. It is enabled
only if you have more than one tab.

!
3.3.3.8

Toolbar button
Split Radar Screen
This splits the radar screen on the current tab into two side-by-side
screens, each of which can be zoomed and panned independently and
can be associated with a different saved view.
When a tab is split into two views, you can select between them
simply by clicking inside them. The selected view will have a red
border drawn around it.
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If the current screen is already split, then this menu item will be
called “Merge Radar Screens” and clicking on it will remove the right
hand screen.
!
3.3.3.9

Toolbar button

Keyboard shortcut Ctrl-S.

Show Elevation
This menu item causes a separate side elevation view to be displayed
below the currently selected radar screen.
If the current screen already has the elevation shown, then this menu
item will be called “Hide Elevation” and will cause the elevation to be
removed.

!

Toolbar button

Keyboard shortcut Ctrl-V.

3.3.3.10 Set View Centre and Bearing
This menu option brings up a dialog box that allows you to enter in a
specific latitude and longitude that the currently selected radar screen
is to be centred on. You can also set the bearing that you wish to be
looking along. By default, this is north, so that the radar scope shows
0º at the top, and the elevation (if displayed) runs from west to east.
Setting the bearing can be useful when you want to align the
elevation with the glidepath that aircraft are following at an airport.
3.3.3.11 Centre on Waypoint
This menu option brings up a sub menu that lists your home position
(the latitude and longitude you entered in as your actual position
when the start-up configuration wizard was running) followed by all of
the waypoints. Selecting any of these will cause the currently selected
radar screen to be centred on the location of that point.
3.3.3.12 Set Elevation Upper/Lower Limit
By default, the upper limit of the elevation view is 50,000 feet with
the lower limit being zero feet. This menu option brings up a dialog
box that allows you to change them.

Figure 6: Set Elevation Limits Dialog Box
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This is useful if you are zooming right in on an airport, watching
aircraft that are just landing or taking off, and are thus very low.
"

Aircraft whose altitude exceeds the elevation upper limit will not be
displayed on the elevation view, even if they are visible on the scope.
The same is true for aircraft whose altitude is lower than the
elevation lower limit.

3.3.3.13 Display All Trails
Selecting this menu option causes the trail of every aircraft on the
selected radar screen to be displayed, regardless of whether or not it
has a tick in the Show Trails column of the Aircraft List. If you
deselect this option, then trails will be shown only for those aircraft
that have a tick in the Show Trails column of the Aircraft List.
!

Toolbar button

Keyboard shortcut Ctrl-T.

Figure 7: Display All Trails menu item/button selected

Figure 8: Display All Trails menu item/button not selected
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3.3.3.14 Show Only Recent Trails
Selecting this menu option causes the aircraft trails to be limited to
the last x seconds (by default to 60 seconds). The number of seconds
to be displayed in this mode can be set under the Aircraft Display tab
of the Settings > Display Settings menu. Deselecting this option will
cause the full trail history to be displayed.
"

This option affects only those aircraft that are set to display their
trails, either using the Display All Trails option above or the Toggle
Tracking on Selected Aircraft option (see the Aircraft menu).

!

Toolbar button

!

Displaying the full trails can significantly increase the processing load
on the computer needed to update the display.
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3.3.3.15 Display Bearing & Distance
Selecting this menu option will cause a range and bearing line to be
drawn on the selected Radar Screen.
!

Toolbar button

Keyboard shortcut Ctrl-B.

Figure 9: Display Bearing & Distance menu item/button selected

Figure 10: Display Bearing & Distance menu item/button not selected
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3.3.3.16 Display Waypoints
Selecting this menu option will cause waypoints to be displayed.
!

Toolbar button

Keyboard shortcut Ctrl-W.

Figure 11: Display Waypoints menu item/button selected

Figure 12: Display Waypoints menu item/button not selected
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3.3.3.17 Display Range Rings
Selecting this option will cause range rings to be displayed.
!

Toolbar button

Keyboard shortcut Ctrl-G.

Figure 13: Display Range Rings menu item/button selected

Figure 14: Display Range Rings menu item/button not selected
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3.3.3.18 Display Outlines
Selecting this option will cause outlines to be displayed.
!

Toolbar button

Keyboard shortcut Ctrl-U.

Figure 15: Display Outlines menu item/button selected

Figure 16: Display Outlines menu item/button not selected
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3.3.3.19 Display Selected Only
This option toggles whether the radar screen displays only the aircraft
that is currently selected. When this feature is active you will see only
one aircraft on the screen.
!

Toolbar button

Keyboard shortcut Ctrl-Alt-S.

3.3.3.20 Display Interested Only
This option toggles whether the radar screen displays only those
aircraft whose Interested field (in the database) is set to True.
!

Toolbar button

Keyboard shortcut Ctrl-Alt-I.

3.3.3.21 Display Centre & Bearing Tracking
This menu item sets whether or not the radar screen will track the
currently selected aircraft and, if so, what factors it will track.
If it is set to None, then the radar screen will stay set to the latitude,
longitude and bearing that you have set for it.
If it is set to Centre Only, then the centre of the screen will always
stay positioned on whichever aircraft is currently selected.
If it is set to Centre & Bearing, then the centre of the screen will
always stay positioned on whichever aircraft is currently selected and
– in addition – the bearing (direction) of the screen will be set to the
current track of the aircraft. The aircraft will appear to be flying
straight up the screen, with the outlines and waypoints wheeling
around it whenever it turns.
"

If the selected aircraft stops being displayed, and you don’t select a
new aircraft, the screen will stay on the last latitude, longitude and
bearing received from the aircraft. Also, if you set this option back to
None, the screen will still stay on the last latitude, longitude and
bearing. In other words, changing back to None will just stop the
screen centre and bearing changing when a new aircraft becomes
selected, but it won’t change the current screen centre and bearing.
If you want to revert to the settings for the saved view, then you
need to click on the Radar > Reset menu option (or alternatively,
reselect the current view in the Saved View drop-down on the
toolbar).
If it is set to GPS, then the centre of the screen will always stay
positioned on the latitude and longitude coordinates supplied by an
attached GPS receiver, assuming that the GPS unit is able to provide
valid coordinates (i.e. that it has got a fix). This menu option is only
visible if you have enabled the use of a GPS feed (by ticking the Use
GPS Feed checkbox on the GPS tab of the Hardware Settings dialog
box).
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3.3.4

Aircraft Menu

3.3.4.1

Expanded All Aircraft List
This menu item duplicates the effect of the Aircraft List Expand
button. Selecting it (so that it is displayed with it a check mark)
expands the aircraft list (see Figure 2). Clicking on it again to
deselect it (no check mark) returns the aircraft list to its normal
width.

3.3.4.2

Show All Aircraft (Inc. Non Position)
This menu item toggles whether all aircraft are to be shown in the
Aircraft List, regardless of whether or not position information has
been received for them. By default, only those aircraft whose
positions are known, and can therefore be plotted on the radar
screen, are shown in the aircraft list.

3.3.4.3

Show Only Aircraft Marked Interested
This toggles whether the Aircraft List shows only those aircraft whose
Interested field (in the database) is set to true. By default, all aircraft
are displayed.

3.3.4.4

Display Full Info Window
This menu option displays a floating window that contains the details
of whichever aircraft is currently selected.

Figure 17: Aircraft Details Window

This details in this window will be updated each second. You can leave
this window visible while you select other aircraft – it will always
display whichever aircraft is currently selected.
!

An easier way to display this window is simply to double-click on
either the aircraft’s box on the Radar Screen, or on the aircraft’s row
in the Aircraft List.
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Clicking on the Edit Details box brings up an edit dialog box that
allows you to enter details for the aircraft.
!
3.3.4.5

You can also edit an aircraft’s details using the BaseStation Reporter
application described later in this manual.
Sort By
This menu option allows you to set which column in the Aircraft List
you wish to sort on.

!

3.3.4.6

An easier way to do this is simply to click on the heading at the top of
the column in the actual list itself. Clicking a second time on the same
column heading will reverse the sort order (indicated by an upward or
downward arrow on the column heading).
Columns
This menu option allows you to set which columns you wish to appear
in the Aircraft List. By default, all columns are visible, but you can
turn off those you do not need.
If a column name has a check mark next to it then that column is
visible. Clicking on a checked item will deselect it and the hide the
column. Clicking on an unchecked column will select it and restore
the column.

3.3.4.7

Toggle Tracking on Selected Aircraft
The selected aircraft is the one that is highlighted in the Aircraft List
(by a solid blue bar) and in the Radar Screen (the aircraft box is
drawn in red). This menu item toggles whether the selected aircraft is
to be tracked (have its trail shown).
Aircraft that are set to be tracked have a tick in the show trail column
in the Aircraft List. The value in that column is overridden however if
the Display All Tracks option is set.

3.3.4.8

Refresh DB Data For Selected
Clicking on this menu option re-reads the database record for the
currently selected aircraft.

"

3.3.4.9

You would normally only need to do this if you’ve just updated the
aircraft’s registration data with BaseStation Reporter (or with another
application) and want BaseStation to re-read the record and get the
updated data.
Centre on Selected Aircraft
This centres the radar screen on the current position of the selected
aircraft. (Note, the Radar Screen will then stay fixed on that particular
point, not the aircraft itself).

!

This option is useful if an interesting aircraft has appeared on your
Aircraft List, but is not visible on the Radar Screen. Rather than zoom
and pan around looking for it, you can simply centre on it.
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3.3.4.10 Caption Position
The first four items on this sub-menu (Top Left, Top Right, Bottom
Left and Bottom Right) allow you to set the radar screen caption for
the selected aircraft to a different position relative to the aircraft. This
is useful when two aircraft are flying close to each other and their
captions are overlapping.
The last two items (Rotate Anti-Clockwise and Rotate Clockwise)
change the caption position of the selected aircraft to the next
position in the indicated direction. For example, if the caption is
currently Top Left and you click on Rotate Clockwise, it will change to
Top Right.
!

You can easily arrange all the captions on the screen by using the
keyboard shortcuts F9 and F10 to cycle through the aircraft, and
using F11 and F12 to rotate the captions clockwise and anticlockwise.

3.3.4.11 Refresh DB Data For All
This command is similar to Refresh DB Data For Selected except that
it refreshes the data for all of the aircraft in one operation.
3.3.4.12 Select Previous Aircraft
This menu option changes the selected aircraft to be the first aircraft
before the current one in the aircraft list that is broadcasting its
position (i.e. has an aircraft symbol).
"

It is quicker to use the keyboard shortcut (the F9 key) to cycle
backwards through the aircraft displayed on the screen.

3.3.4.13 Select Next Aircraft
This menu option is identical to the Select Previous Aircraft option,
except that it cycles forwards through the aircraft list, and its
keyboard shortcut key is F10.
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This menu option brings up the Display Settings dialog box:

Figure 18: The Display Settings dialog box (General Colours tab)

The settings on the General Colours tab concern the colours used
by the application. If you want to experiment with colours, then
clicking the Apply button saves the updated colours – which will cause
the application to start using those colours – without exiting the
dialog box.
Radar Display: These set the colours used on the Radar Screen.
Line sets the colour used in the Range Rings (and the horizontal lines
in the Elevation view) as well as the text associated with the Range
Rings.
Select Box is the colour used both for the box around a selected
Radar Screen as well as the colour used to display a selected aircraft.
Bearing Line is the colour used to display the bearing and range line
for the selected aircraft.
Aircraft List Display: These set the colours used in the Aircraft List.
Aircraft Status (Radar): Position Lost sets with which colour is used
to display aircraft on the radar screen if the Position Lost timeout
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period has been exceeded. The default colour is yellow. For more
information about the timeout see the description of the Settings >
Data Settings menu item.
Aircraft Status (List): Okay, Position Lost and Signal Lost define
the colours used for the aircraft symbol in the Status column of the
Aircraft List. For more information about the Aircraft Status see the
description of the Settings > Data Settings menu item.
Aircraft Vertical Direction: These set the colours used to display
aircraft on the Radar Screen, including the box representing the
location of the aircraft, the caption text, and the line connecting the
two. Aircraft are coloured according to whether they are ascending,
descending, flying level, or on the ground. However, if no signal is
received for the Position Lost timeout period (by default, this is 30
seconds), the aircraft changes to the colour set by the Position Lost
colour setting – regardless of whether it was ascending, descending,
level, or on the ground.
Track Vertical Direction: These settings define the colours used for
the aircraft trails. These are similar to the Aircraft Vertical Direction
settings, except that there is no Position Lost colour. This is because
each dot in the track represents a time when a position was received.
Full Info Window Colours: These settings select the colours used in
the Full Info Window.
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Figure 19: The Display Settings dialog box (Display Parameters tab)

The Display Parameters tab allows the user to configure various
aspects of BaseStation’s screens.
Radar Drawing:
Bearing Lines determines how many segments the radar display will
be divided into by the range rings. The minimum is four, which gives
four quadrants.
If Ticked Bearing Lines is checked then small ticks are drawn instead
of the radial lines.
If Fixed Size Bearing Rings is checked, then the bearing rings are
drawn at fixed distances from the centre of the rings, rather than
being sized to fit the view. By default, fixed size rings will be drawn at
radii of 5, 10, 20 and 40 nautical miles, but this can be changed using
the Radius Sizes spin edit controls.
If Centre Range Rings on Home is checked, then the range rings are
centred on the currently selected location (i.e. home), rather than
being centred on the view.
Waypoint Radius controls the size of the dots that are drawn for
Waypoints.
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General:
If Draw Location Waypoints is selected then a waypoint is drawn at
each location defined by the Locations Manager (this is an easy way
of having a waypoint drawn at your home position).
The Clip Above Max Elevation and Clip Below Min Elevation options
will, if set, cause the radar screen to display only those aircraft whose
altitude is below and above the maximum and minimum altitudes
defined in the Set Elevation Limits dialog box.
If Invert Show Interested is checked, the the Display Only Interested
and Show Only Interested buttons work in the opposite way – that is,
selecting them will cause only aircraft that you have not marked as
interested to be displayed.
Zooming & Panning: These parameters determine how far the
screen moves sideways while panning (decreasing the number will
increase how far it pans), and by which percentage of the existing
view it zooms in each step when zooming in and out.
Colour Selection: Aircraft flying notionally level sometimes make
slight up and down movements. To avoid displaying “rainbow
coloured” trails, changes of less than the configured amount are
ignored when determining which colour to use for the next dot in the
trail.
Status Bar:
If Show latitude and longitude of mouse cursor position is checked,
then a panel appears on the status bar at the bottom of the
application window, that shows the latitude and longitude of the
position on the radar screen that the mouse pointer is currently over.
If Show range and bearing of selected aircraft is checked, then a
panel on the status bar appears that shows the range and bearing of
the currently selected aircraft. The data displayed is the same as that
displayed on the radar screen when the Display Bearing & Distance
option is selected, but the status bar be easier to read when the
display is cluttered.
Aircraft List:
If Allow Interested Key Toggle is set to true, then you can toggle the
status of an aircraft’s Interested field by simply selecting it in the
Aircraft List and then pressing the I key. This setting is set to false by
default in order to guard against inadvertent editing of the database.
Confirm on Close: If this box is checked then you will be asked “Do
you really want to shut BaseStation down?” each time you close the
application.
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Figure 20: The Display Settings dialog box (Aircraft Display tab)

The Aircraft Display tab allows configuration of the way aircraft are
displayed on the screen.
Aircraft Captions: These settings configure which data items are
displayed in the caption beside each aircraft on the radar screen.
Subst Reg for ModeS is a special case that can be used where the
ModeS field has been set to be displayed (using the Scope Fields tab).
If checked, then the aircraft’s radar screen caption will show the
ModeS code where it does not have a registration for that aircraft, but
the registration instead where it does.
#

This means that if you have this option checked, you should set the
Registration field (in the Scope Fields tab) to not be displayed –
otherwise you’ll end up with Registration being shown twice.
Caption Line Spacing allows you to set the gap between each line of
text in the radar caption.
Default Position sets where the caption will, by default, be drawn on
the radar screen relative to the aircraft.
Aircraft Drawing:
Highlight If Selected sets whether the aircraft that is currently
selected (this is also shown by a blue highlight bar in the Aircraft List)
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should be highlighted on the Radar Screen by being drawn as a red
box (rather than whichever colour would indicate its ascending/
descending/level/ground status). This is the default behaviour.
Show Trails For Non Visible Aircraft sets whether or not trails are
displayed for aircraft that are no longer visible. By default, if an
aircraft disappears from the screen, either by flying off the edge, or if
no message is received from it for 35 seconds (or the time configured
using Settings > Data Settings), then the trail is also removed from
the screen. The trail will only reappear if the aircraft itself reappears.
However, if you check this setting, then the trail will continue to be
shown until the aircraft is removed from the Aircraft List (which by
default happens if no message is received for a further 5 minutes).
Recent Trails Include The Last x Seconds allows you to define the
number of seconds to be included in the most recent portion of an
aircraft trail, whenever the Show Only Recent Trails mode is set. Note
that this only applies if the aircraft set to have its trail drawn, or if
Display All Trails is selected.
Show Leader Lines For Next x Seconds allows you to configure
BaseStation to draw lines ahead of an aircraft, showing its predicted
path over the selected period. This is a demonstration feature, to be
implemented more completely in a future release of BaseStation.
Aircraft Field Display:
The Show FL For Altitudes Above x Feet control will, when set, cause
altitudes above that level to be shown as flight levels rather than in
feet. For example, an altitude of 8500 feet would be shown as FL85.
The Interested Radar Tag and the Interested Aircraft List Tag
configure which characters are used if the Interested field is displayed
on the radar screen or in the Aircraft List respectively.
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Figure 21: The Display Settings dialog box (Text tab)

The Text tab allows configuration of certain text displayed on the
screen.
Text Sizes: These boxes set the size of various categories of text
that are written to the radar screen.
Radar Screen Font: This determines which font is used to draw the
text on the radar screen.
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Figure 22: The Display Settings dialog box (Printing tab)

The Printing tab determines how radar screen images are printed.
Print Background sets whether or not the background (which by
default is black) is printed when you print the radar screen. Leaving
this box unchecked will generally result in less ink or toner being
consumed by the printer.
Print Black and White sets whether the radar screen is printed in
black and white instead of colour.
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Figure 23: The Display Settings dialog box (Waypoints tab)

The Waypoints tab allows you to set the colours used for each type
of waypoint. It also allows you to select which types of waypoints you
wish to be visible (check the checkbox to make them visible, uncheck
it to hide them).

Figure 24: The Display Settings dialog box (Outlines tab)
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The Outlines tab lets you set the colours used for each type of
outline. It also allows you to select which types of outlines you wish
to be visible (check the checkbox to make them visible, uncheck it to
hide them).

Figure 25: The Display Settings dialog box (Data Files tab)

The Data Files tab displays the outline and waypoints files that are in
the folders (Installation path)\Outlines and (Installation path)
\Waypoints respectively, where (Installation path) denotes the folder
where BaseStation is installed. The tab allows you to select which
specific files are loaded.
To stop a file being loaded, simply uncheck the checkbox next to its
name. When you click on OK or Apply, the system will purge and
reload the waypoint or outline lists, loading only those files you have
set to be loaded.

© 2005-2013 Kinetic Avionics Limited.

This document is subject to the terms of the included EULA.

BaseStation Reference Manual

Page 44 / 108

Figure 26: The Display Settings dialog box (Scope Fields tab)

The Scope Fields tab gives you complete control over the fields that
are shown in the aircraft tags on the radar screen.
For each field that can be displayed in the caption, you can set four
settings:
• Show: This sets whether or not the field will be displayed. If this
checkbox is not checked, then the field will not be displayed the
other three settings for this field are ignored.
• Row: This setting determines which row of the tag the field will
appear in. By default, there are two rows, but you can have up to
five. Row must be set to a value between 1 and 5.
• Order: This setting determines the order in which fields are
displayed on a row (whereas the Row parameter sets which row
they are displayed on).
• Style: This sets the style in which the field is displayed. If set to
the default (Standard) then the field value is simply copied into the
caption. Alternatively, you can opt to have the value enclosed by
brackets, have dashes or bars before or after it, and so on.
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Figure 27: The Display Settings dialog box (Label Formats tab)

The Label Formats tab allows you to set the ways in which field
values are displayed on the radar scope and in the aircraft list. This
enables you to have as much, or as little, detail as you wish, which
can be a great help if the radar scope is getting cluttered.
For example, by default the setting for the ground speed field on the
radar scope is:
Prefix:

[blank]

Format:

#0.0

Suffix:

kts

Divisor:

1

This will caused the radar scope to display track values in the form:
157.3 kts (note that there is a space before the kts in the Suffix edit
box).
If you changed it to the following:
Prefix:

G

Format:

#0

Suffix:

[blank]

Divisor:

1

it would display values in the form: G157 (note that in this example,
there is no space after the G).
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You can use the divisor setting to modify the value displayed. If you
changed the divisor of the above example to 10, for example, the
value displayed would change to G16.
"
3.3.5.2

The Prefix and Suffix fields can contain any text. The Format field
however should contain only the characters “#”, “0”, “,” and “.”.
Data Settings
This menu option brings up the Data Settings dialog box:

Figure 28: The Data Settings dialog box (SBS tab)

Message Filtering:
Ignore Non ADS-B Mode-S Messages: By default BaseStation
receives and processes both ADS-B and non-ADS-B Mode-S
messages. However, you can turn off the processing of non-ADS-B
messages by checking the Ignore Non ADS-B Mode-S Messages
checkbox.
Process Mode-S Air to Air Replies:

SBS-3 SBS-1eR SBS-1e, 1090 Puck
Enables forwarding by the SBS or Puck of Mode-S Air-to-Air
Surveillance Replies (TCAS Replies). As these contain altitude
information, this may enable BaseStation to display the altitude of
non-ADS-B but Mode-S equipped aircraft, even when they are outside
the coverage of Mode-S radar stations.
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"

Enabling this feature will significantly increase the amount of data
transmitted from the SBS or Puck to the PC, and hence the bandwidth
required when connecting over a network.

"

This feature is available currently available only on the SBS-3, 1090
Puck and SBS-1e/eR and will also require a firmware update on the
SBS-1e/eR if the firmware build number displayed by the Help >
About BaseStation menu is less than 517.
Process TIS-B Messages:

SBS-3 SBS-1eR SBS-1e, 1090 Puck
This enables processing of TIS-B messages by BaseStation. These are
similar to ADS-B messages, but are broadcast by radar ground
stations, mainly in the USA to relay data about non-ADS-B aircraft,
so that aircraft equipped with ADS-B receivers can “see” them.
"

This feature will require a firmware update on the SBS-1eR or SBS-1e
if the firmware build number displayed by the Help > About
BaseStation menu is less than 517.
Process ADS-R Messages:

SBS-3 SBS-1eR SBS-1e, 1090 Puck
This enables processing of ADS-R messages by BaseStation. These
messages arise because there are two channels used for ADS-B in the
USA. These are the 1090 MHz world-wide radar reply channel
monitored by BaseStation, and also the 978 MHz UAT channel which
uses a different transmission format. Ground stations in the USA are
being equipped to re-broadcast data received on one channel as
messages on the other channel. This allows differently equipped
aircraft to be aware of each other.
"

This feature will require a firmware update on the SBS-1eR or SBS-1e
if the firmware build number displayed by the Help > About
BaseStation menu is less than 517.

"

TIS-B and ADS-R messages are intended to be transmitted from
ground to air and normally will be received only if the antenna is
within line-of-sight of a ground station.
Relay Mode A/C Messages:

SBS-3, 1090 Puck

This checkbox enables output of Mode A and C data on BaseStation’s
raw data output over Ethernet (port 30006). BaseStation does not
currently use Mode A/C messages itself but they can be used by third
party applications connecting to this port. Enabling this option will
increase data bandwidth significantly.
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Process Non-ICAO Addresses:

SBS-3 SBS-1eR SBS-1e, 1090 Puck
Aircraft or ground vehicles equipped with Mode S radar transponders
use 24-bit addresses from a block allocated to each country by ICAO
and which are unique to a particular aircraft or vehicle. This is the
code that is displayed as a 6-character hexadecimal number by
BaseStation. However ADS-B, TIS-B and ADS-R messages that do not
originate from Mode S transponders are allowed to use a different set
of 24-bit addresses that are not allocated by ICAO and do not have to
be unique. This applies for example to certain ground vehicles. TIS-B
messages may also use a 24-bit address made up of the 12-bit Mode
A (Squawk) code plus a 12-bit track number allocated by the radar
station.
If you enable this feature then BaseStation needs to use special
processing for the non-ICAO addresses to avoid incorrect lookup and
display of countries, aircraft registrations etc. There is no way for
BaseStation to determine the country for a non-ICAO address, and
there is no guarantee that such an aircraft or ground vehicle will
consistently use the same address.
As the database currently uses a fixed 6-character field for the
aircraft address, BaseStation distinguishes non-ICAO addresses by
modifying the first character of the displayed hex code as follows:
0 -> G
1 -> H
2 -> J
3 -> K
4 -> M
5 -> N
6 -> P
7 -> Q
8 -> R
9 -> S
A -> T
B -> U
C -> V
D -> W
E -> X
F -> Y
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This means that the code does not conflict with the existing ICAO
addresses in the database, while still fitting within the 6 character
aircraft address field.
For the ModeA/Track number addresses (used by TIS-B only) the last
digit is modified instead.
The setting Output Non-ICAO Addresses enables these aircraft to
be output to the data port for use by third party applications. Leave
this option unchecked if the application cannot handle the modified 6character codes.
The setting Save Non-ICAO Addresses to DB enables saving of
aircraft with these addresses to the database. Again, you can leave
this option unchecked if the database is used by a third party
application that cannot handle the modified 6-character codes.
Timeouts (Seconds): These parameters dictate how the application
responds when it stops receiving messages from an aircraft.
If a preset number of seconds (configured using the Position Lost
box) has elapsed since the time the last message was received, the
aircraft changes to a state of “position lost”, and is shown as yellow
(by default) on both the Radar Screen and in the Aircraft List.
If a further period (set by the Signal Lost box) elapses without
receiving a message, the aircraft changes to a state of “signal lost”
and is removed from the Radar Screen and shown as red in the
Aircraft List.
If a further period elapses without receiving a message (configured in
the Remove box) then the aircraft is removed from the Aircraft List.
When a final period (set by the Delete box) has elapsed, the aircraft’s
data is purged completely from memory.

Figure 29: The Data Settings dialog box (Database tab)
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On the Database tab, BaseStation can be set to purge (delete) data
over a certain age each time it shuts down. It can do this for both the
Flights and System Events tables. By default, it leaves the Flights
table alone, but will delete all records in the System Events table that
are more than 7 days old.

© 2005-2013 Kinetic Avionics Limited.

This document is subject to the terms of the included EULA.

BaseStation Reference Manual

3.3.5.3

Page 51 / 108

Hardware Settings
This menu option brings up the Hardware Settings dialog box:

Figure 30: The Hardware Settings dialog box (Network tab)

The Network tab is relevant only if you have an SBS-3, SBS-1eR,
SBS-1e or an SBS-1EM add-on Ethernet module for your SBS-1. If
you do, then enter the IP address it has on your network and the port
that you use to connect to it (which will usually be 10001).

Figure 31: The Hardware Settings dialog box (Radio Tab)

The Radio tab is used to configure the external radio interface (see
chapter 3).
The Radio Interface Library setting allows you to select a BaseStation
Interface Unit (.BIU) file that implements an interface to the radio
(scanner) that you use.
"

Selecting an interface file will cause the Radio menu to appear in the
main application menu bar.
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The Serial Port drop down box allows you to select between having
the external scanner connected to your PC’s serial port (the standard
option) and the SBS unit’s serial port (useful when your PC does not
have a serial port).

Figure 32: The Hardware Settings dialog box (GPS tab)

The GPS tab allows you to configure the system to use an attached
GPS unit to provide location data to BaseStation.
#

The GPS unit must output standard NMEA data to a serial port on the
PC (or a USB port configured to emulate a serial port).
To enable the use of GPS, simply check the Use GPS Feed checkbox,
and then enter the appropriate values into the edit fields below.
Once this value is checked, a GPS status panel will appear on the
status bar (you have to restart BaseStation for this to occur), and a
GPS Status menu option will become visible in the Settings menu.
Whenever the GPS unit is providing valid data (i.e. it has a fix – see
the GPS Status menu option for further details), the latitude and
longitude coordinates that it is outputting (i.e. your current location)
will be used in preference to the coordinates of the currently selected
location. This applies when you have opted to centre the range rings
on the current location (GPS location will be used instead) and when
you have opted to have range and bearing lines drawn from the
current location (GPS location will again be used).
The Audio tab has settings relating to digital audio streaming from
the built-in radio on the SBS-3, SDR Puck or SBS-1eR. These settings
are described in the section on Using the Built-in Radio.

3.3.5.4

Install Firmware Option
Clicking on this menu item brings up the following dialog box:
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Figure 33: The Install Firmware Option dialog box

This menu item is used to enter Firmware Option License Codes into
the SBS-3, Puck or SBS-1 family device to activate any future
features that are sold as separate options. Instructions for doing this
will be included in any such feature packages that you purchase.
3.3.5.5

Data Source
This menu item has two options: Use USB and Use Network. You
should select Use Network only if you have an SBS-3, SBS-1eR,
SBS-1e or an SBS-1EM add-on Ethernet module for your classic
SBS-1, and have configured its use via the Network tab of the
Hardware Settings dialog box. If all of these conditions apply, then
you can toggle between using USB and using the network by clicking
on the corresponding option in this sub-menu.

3.3.5.6

Locations Manager
Clicking on this item brings up the following dialog box:

Figure 34: The Locations Manager dialog box

The Locations Manager allows you to define the positions from which
you intend to use BaseStation. By default, you will have one location
defined called “Home”, which will have the latitude and longitude
value that you entered into the Startup Configuration wizard.
If you use BaseStation in a different location, then you can either edit
the values of your Home location or create an additional location.
To add a new location, simply click on Add, enter the location name,
the latitude, the longitude and the altitude (can be zero) and then
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click on save. To edit an existing location, select it, click on edit,
change the required details, and click on save. To delete a location,
select it and click on delete.
#

You cannot delete a location that has been used while you were
recording data. This is because there are flights in the database
linked to that location. You can only delete a location if you have not
yet used it.
For more details on location, including how to set the current
location, please see the section on the Current Location Selector in
the Toolbar chapter.

!

The Locations Manager can also be opened by clicking on the toolbar
button

3.3.5.7

GPS Status
This menu item appears only if BaseStation has been configured to
receive position data from an external GPS unit attached on a serial
port (See Hardware Settings Menu, GPS tab). Clicking on this item
brings up the following dialog box:

Figure 35: The GPS Status dialog box

This floating window shows the current status of the GPS connection.
It can have three states:
Off: This indicates that BaseStation is not receiving any messages
from the GPS unit (for example if it is turned off or disconnected).
This is shown as dark red in both this dialog box and on the status
bar.
Down: This means that BaseStation is receiving messages from the
GPS unit, but that those messages are telling BaseStation that the
GPS unit is not currently able to obtain a fix to determine its location.
This is shown as bright red in both this dialog box and on the status
bar.
Up: This means that the GPS has informed BaseStation that it is now
fully operational and delivering valid coordinates. This is shown as
bright green in both this dialog box and on the status bar.
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Toolbars
This menu item brings up a sub-menu allowing you to hide or show
individual parts of the toolbar.

3.3.5.9

Status Bar
This menu option allows you to hide or show the status bar.

3.3.5.10 Sidebar
This menu option allows you to hide or show the sidebar.
3.3.5.11 Reload
Reload Outlines causes all outlines to be reloaded. You would
normally only do this if you have modified an existing outline file or
added a new one.
Reload Waypoints causes all waypoints to be reloaded. You would
normally only do this if you have modified an existing waypoint file or
added a new one.
Reload Flags causes the country definition file countries.dat, plus all
country and operator flags to be reloaded. You can use this if you
have modified or added flag bitmap (.BMP) files.
3.3.5.12 Hide Main Window
When using an SBS-3 or SDR Puck, Basestation can be used without
the main (radar display) window, which may be hidden using the
Settings>Hide Main Window menu option. Selecting this option in
effect makes the SDR Control Panel the main window of the
application, with a limited set of menu items.
Please refer to section 4.1 of this manual for instructions on using the
SDR Control Panel.
!

You can also use the keyboard shortcut Ctrl-Alt-W.
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This menu option displays the PDF file containing the BaseStation
Reference Manual (this document).
3.3.6.2

Release Notes
This menu option displays the release notes for installed version of
the BaseStation application.

3.3.6.3

BaseStation Websites
This submenu can launch (in your default browser) various
BaseStation related web sites that can be used to get help and
information about the BaseStation software and SBS-3, Puck and
SBS-1 family products.

3.3.6.4

User Websites
This submenu can launch websites that are not connected with the
BaseStation software but might be of interest to users.

!
3.3.6.5

Toolbar button
About BaseStation
This menu option launches an About dialog box that displays various
information, including the version number of your BaseStation
software and the firmware version installed in your SBS or Puck
device. It also lists any firmware options you have installed.

© 2005-2013 Kinetic Avionics Limited.

This document is subject to the terms of the included EULA.

BaseStation Reference Manual

Page 57 / 108

3.4

Aircraft List

3.4.1

What The Aircraft List Shows
The Aircraft List has an entry for each aircraft that BaseStation is
currently receiving messages from.
The Status column shows the transmission status of the aircraft by
means of colour-coded symbols. Green indicates that transmissions
are being received from the aircraft. Yellow indicates that more than
30 seconds have gone by without receiving a transmission. Red
indicates that 35 seconds have gone by without receiving a
transmission.

!

These timeouts can be changed using the Settings > Data Settings
menu item. The colours can be changed using the Settings > Display
Settings menu item.
If the symbol is an aircraft then it indicates that ADS-B messages
that contain latitude and longitude data are being received from this
aircraft.
If the symbol is a solid circle ($) then this indicates that ADS-B
messages are being received from the aircraft, but that they do not
contain latitude and longitude data.
If the symbol is four diamonds (%) then this indicates that only
Mode-S messages are being received from the aircraft (but no ADS-B
messages).
The State column uses colour coded arrows to indicate whether the
aircraft is:
• Ascending: a thick, upward pointing blue arrow
• Descending: a thick, downward pointing brown arrow
• Flying straight and level: a thick, horizontal blue-green arrow
• On the ground: a horizontal arrow as for flying straight and level,
but thin and grey.
The Show Trail column indicates whether or not the aircraft is being
individually tracked. A tick indicates that it is.
The Flag column displays the flag corresponding to the country of the
aircraft (see the Country field below).
The Operator Flag column can be used to display a graphic for each
aircraft, typically to show its operator. Operator flag graphic files must
be in .bmp format and must be placed in an OperatorFlags
subdirectory. To set an aircraft to display the operator flag, enter the
name of the file minus the .bmp extension into the Operator Flag
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Code field of of the Edit Aircraft Details dialog box in the Aircraft
Details Window.
For example, if you enter “BAW” into the OperatorFlagCode field of an
aircraft, and you have previously placed the file BAW.bmp into the
folder (Installation path)\OperatorFlags, then the bitmap from
BAW.bmp will be displayed in the Operator column for that aircraft.
"

Third party applications may be used to populate operator codes in
the database.
The Interested column displays a symbol if the aircraft has been
marked as one that you are interested in. See the description of the
Aircraft > Show Only Aircraft Marked Interested menu item for more
details.
The Code column shows the 24-bit Mode-S address of the aircraft. It
is displayed as six hexadecimal digits. A range of addresses is
assigned to each country by ICAO, and the country then assigns
addresses within its allocated range to aircraft registered there. The
address code is used by BaseStation to identify individual aircraft
uniquely.
The Callsign column shows the call-sign identification of the flight.
This is sent by the aircraft in ADS-B messages.
The Registration column shows the registration mark of the aircraft.
This can be set for each aircraft using the Registration field in the
Aircraft Details Window or a third party database population tool.
The User Tag column contains user text that can be set for each
aircraft using User Tag field in the Aircraft Details Window.
The ICAO Code column shows the ICAO operator code of the
aircraft. This can be set for each aircraft using the Operator Flag Code
field in the Aircraft Details Window or using a third party database
population tool. This code is used also by BaseStation to determine
which bitmap to display in the Operator Flag column.
The Country column shows the country of registration of the aircraft.
This is determined automatically by BaseStation from the Mode-S
address of the aircraft using information in the file countries.dat.
The Altitude column shows the altitude that was last reported by the
aircraft. By default this is displayed in feet but may optionally be
displayed as a flight level. See the Settings > Display Settings menu
for details.

"

Aircraft on the ground do not report their altitude in ADS-B
messages, and will be displayed with an altitude of zero.
The Latitude and Longitude columns display the last reported
position of the aircraft, if any.
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The Speed column shows the aircraft’s ground speed, in knots, if
reported. Not all ADS-B equipped aircraft report their velocity over
the ground.
The Track column shows the track angle of the aircraft over the
ground, in degrees, if reported.
The Vertical Rate column displays the rate of climb (or descent if
negative) of the aircraft in feet per minute. Not all aircraft report this
information.
The Squawk column shows the “squawk” code, if any, that the
aircraft is transmitting (this is also known as the Mode A or Mode 3
code). This is a four digit code where each digit is in the range 0 to 7,
giving 4096 possible codes. Under certain circumstances, the squawk
code will be displayed with a symbol after it. The possible symbols
are:
* (Ident): Transmitted when the pilot presses the "Ident" button in
response to a request from Air Traffic Control. Normally transmitted
for 18 seconds.
+ (Alert): Transmitted when the squawk code changes (usually for 18
seconds).
E (Emergency): Indicates that the squawk is one of a number of
internationally agreed codes defined to indicate an emergency. These
include 7700 (emergency condition), 7600 (radio failure) and 7500
(unlawful interference).
The Last Update column displays the time that the last message was
received for that aircraft.
The Time Tracked column shows the time that has elapsed since the
first message was received for the aircraft.

3.4.2

Using The Aircraft List
To select an aircraft, simply click on that aircraft’s row. You can move
the selection up and down by using the arrow keys.
Initially, the Aircraft List is sorted on Last Update. This means that
as new aircraft appear, their rows are inserted in at the top, with the
existing rows shuffling down.
To sort on a different column, simply click on that column’s heading.
The column that is the current sort column is drawn depressed as an
indicator, and has an arrow showing the direction of sort. (Some
columns default to ascending, others to descending). You can toggle
the direction of sort by clicking a second time on the heading.
You can toggle the “show track” status of the currently selected
aircraft with the space bar.
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Double-clicking on the Aircraft List will bring up the Aircraft Details
window. Once that is visible, it will display the details of whichever
aircraft is selected.
Finally, right-clicking on the Aircraft List will display a pop-up menu
containing the menu options that particularly apply to the Aircraft
List.
The Show All button determines which aircraft are shown on the
aircraft list. It duplicates the functionality of the “Show All Aircraft
(Inc. Non Position)” menu item in the Aircraft menu (see the
description of that item for details).
The Int Only button also determines which aircraft are shown on the
aircraft list. It duplicates the functionality of the Aircraft > Show Only
Aircraft Marked Interested menu item (see the description of that
item for details).

3.4.3

Customising The Aircraft List
You can change the width of the columns by clicking on the dividing
line between two column headings and dragging it to the left or right
with the mouse.
You can opt to hide or display certain columns using the Columns
submenu of the Aircraft menu.
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Toolbar
Most of the items on the toolbar are duplicates of commonly used
menu items, and are described in the section above. However, there
are four items that are unique to the toolbar, and are described in this
section.

Figure 36: The BaseStation toolbar

3.5.1

Zoom Diameter Selector
Popping this down offers a range of specific zoom diameters (the
width, in nautical miles, of the real-world area covered by the radar
scope range rings) to set the current view to. You can also type in a
specific number.

3.5.2

Zoom Diameter Slider
This offers an alternative way to zoom in and out. Simply slide to the
left to zoom in, and to the right to zoom out.

3.5.3

Saved View Selector
This allows you to select a previously saved view to apply to the
current view. The current view (zoom diameter, zoom centre and
display toggle settings) will change to the settings saved in the saved
view.

3.5.4

Current Location Selector
This allows you to change which of your previously defined locations
is the one you are currently at. Setting the correct location is
important for a number of reasons:
• The system will use the correct current latitude and longitude when
decoding messages picked up from aircraft on the ground, thus
ensuring that their positions are correctly decoded. This is because
aircraft on the ground do not transmit their full global position in
the ADS-B messages, so decoding the correct position relies on
knowing the location of the receiving unit, and the assumption that
the aircraft will be within a few hundred miles of the receiver.
• If you later browse the flight in BaseStation Reporter you will be
able to see the location from which the aircraft was detected.
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• If you use BaseStation Logger to log the data messages received
for later analysis, you will be able to distinguish between messages
received from different locations.
#

To display aircraft on the ground correctly, their true position must be
within approximately 45 degrees of latitude and 45 degrees of
longitude from the currently selected location.
For more information about locations, see the entry for the Locations
Manager under the Settings menu.

!

The Locations Manager can also be opened by clicking on the toolbar
button

next to the current location selector.

!

You might typically change the location if you run your system on a
laptop and are using it outside your home.

"

When you change the current location, it is changed for the entire
session. If you started BaseStation at 9:01 am and at 9:03 am
change the location, the software assumes that you’ve been at that
new location since you started up.
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Sidebar
The sidebar offers duplicates of some of the controls in the main
toolbar, plus one unique control: the Full Screen button.

Figure 37: The BaseStation side bar

Clicking on the Full Screen button puts the application into full screen
mode. In this mode, the application occupies the entire screen
(including the area where the taskbar would normally be) and all
controls except for the sidebar and the radar screen are hidden (i.e.
no menu, no toolbar, no status bar and no aircraft list).
This mode is ideal if you want to concentrate on the Radar Screen
alone without any distractions.
To get out of full screen mode, simply click on the Full Screen button
again.
!

Full screen mode can also be toggled by pressing Ctrl-Alt-F or via a
popup menu by right clicking on the radar screen.
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4

Radio Interfaces

4.1

Using the SDR Receivers on the SBS-3 and SDR

Puck
4.1.1

What is Software Defined Radio ?
With Software Defined Radio (SDR), instead of using dedicated
hardware to allow reception of say AM or FM radio stations, the
incoming radio signal is digitised and then processed in real time by
software to extract the desired audio or data. This means that
different features or types of processing can be added with out
needing to change the hardware.

4.1.2

Introduction to SDR on the SBS-3 and SDR Puck
The SBS-3 has two Software Defined Radio (SDR) tuners, called tuner
A and B. The SDR Puck has tuner A only.
Each of these digital tuners can receive a continuous frequency span
(bandwidth) of 8 MHz.
The centre frequency of each tuner’s frequency span can be set
anywhere within the range 27 MHz to 980 MHz, and they may
overlap.
There are then six independent SDR demodulator channels within the
SBS-3 or SDR Puck, called SDR 1 to 6, which can process the
digitised data from the two tuners. This allows up to 6 stations to be
“picked out” simultaneously from the two 8 MHz tuner spans.
Each SDR channel can be tuned to any frequency within the tuned
span of either tuner A or B. The demodulation type for each channel
can be set independently to AM or FM. These demodulate the narrow
band transmissions typically used in the aircraft, marine and other
communications bands. SDR Channel 1 can also be set to Wideband
FM mode for receiving FM broadcast radio transmissions, or the sound
channels of analog terrestrial TV.
Each SDR channel can be used to decode ACARS data from aircraft if
tuned to a suitable VHF frequency. This allows up to 6 ACARS
channels to be decoded simultaneously.
SDR channel 6 can be used to decode AIS marine data. It can decode
both AIS channels (161.975 MHz and 162.025 MHz) simultaneously
using only one SDR channel.
In the future it is expected that other types of demodulation will be
supported.
Because they incorporates true SDR, the SBS-3 and SDR Puck have
no restrictions to the types of demodulator that can be implemented,
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or number of channels that can be received, other than the practical
limits set by the hardware resources in the FPGA.
Kinetic may in the future offer different firmware sets allowing various
combinations of features (such as number of channels and
demodulators) to suit particular environments.

4.1.3

Using the SDR Control Panel
The SDR features are accessed by a Control Panel. This is a separate
window within BaseStation that can be launched either by using the
“Built-In SDR” - “Control Panel” menu item, or by clicking on the
Control Panel toolbar button, which is the leftmost button on the
built-in SDR toolbar:

Figure 38: The Built-in SDR Toolbar

!

You can also use the keyboard shortcut Ctrl-Alt-P to launch the Radio
Control Panel.
If the Built-in SDR toolbar is not visible, it can be enabled by using
the “Settings” - “Toolbars” menu.
If the external radio interface is also enabled then both sets of
buttons will appear:

Figure 39: The Radio Toolbars With Both Radios Enabled

The external radio interface is described further in the next section.
!

4.1.3.1

The other items on the Built-in SDR toolbar and menu can be used to
control certain features of the radio without opening the control
panel. You can use them to tune to a frequency from BaseStation’s
database, or alter the master volume and mute settings. See the
section below on Using the Built-in SDR Toolbar and Menus.
Controlling the Tuners
The top part of the SDR control panel concerns the two tuners, A and
B. There is a frequency display for each tuner, and below the two
displays there is a slider bar.
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Figure 40: The Tuner Control Panels

Each tuner can be turned on or off using the buttons on the left side
of the corresponding panel. Initially they will both be turned off and
the frequency display will show “Off”.
Once a tuner has been turned on, its centre frequency can be set and
will be displayed in the corresponding tuner panel. This frequency can
be set using either the slider bar or a pop-out keyboard.
The slider bar can be used as a coarse control to set the centre
frequency for the currently selected tuner. This is the tuner whose
frequency is shown in bright green (Tuner B in the example screen
shot).
Alternatively you can enter a frequency using a pop-up keypad. To
bring up the keypad, click on the “>” key at the right of the tuner
display for which you wish to enter the frequency. Clicking on the “>”
key again hides the keypad, or you can click on the “>” key for a
different tuner, and the keypad will move to that tuner.

Figure 41: The Frequency Keypad

Click on the keys (or use the PC’s keyboard) to enter the required
frequency and then press Enter.
Remember, each tuner can capture an 8 MHz band within the radio
spectrum. So for example if you are interested in some stations in the
lower part of the aviation AM voice band, you could tune the centre
frequency of one of the tuners to 122 MHz and that would enable you
to receive channels between 118 and 126 MHz.
As another example, selecting a centre frequency of 160 MHz would
cover the international marine FM band, between 156 and 164 MHz.
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"

The centre frequency for each tuner must be within the range 27 MHz
to 980 MHz. If you set a frequency outside this range, the frequency
display will change to red.

"

The Automatic Gain Control (AGC) display for each tuner shows the
current amount of signal attenuation within each tuner. This is
displayed in units of decibels (dB). A value of 0 means no
attenuation. The reason for attenuating the signal is if there is a
strong transmission within or near that tuner’s frequency span that
would otherwise overload the tuner or the analog to digital converter.

4.1.3.2

Controlling the SDR Channels
Below the two tuner displays and associated slider, there is a panel
for controlling each of the six SDR channels, SDR 1 to 6.

Figure 42: SDR Control Panel

For each SDR channel there are buttons for selecting the tuner
source, A or B. Then you can use the slider bar below to select the
required frequency from the 8 MHz span of that tuner. The slider bar
operates on the currently selected SDR channel - the one with the
bright green display - the other three channels will have a darker
green display. You can select a channel by clicking within the
corresponding panel. The end points of the slider bar will change
according to span of the selected tuner.
Alternatively as before, you can bring up the pop-up keypad to enter
a frequency, by clicking on the “>” button at the right of the SDR
panel.
These channels may be placed anywhere within the 8MHz spans of
either tuner A or tuner B or both.
"

If you set a frequency outside this range, i.e. more than 4MHz away
from the centre frequency of the tuner, the SDR channel’s frequency
display will change to red.
As well as the frequency, you can set the modulation type for the SDR
channel, AM or FM. Just click on the corresponding button at the left
of the panel.

"

SDR1 also has WFM, allowing listening to broadcast FM and the sound
channels of terrestial analog TV, etc.
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For each SDR channel the Received Signal Strength Indication (RSSI)
is displayed. This is a number indicating the relative strength of the
radio signal being received on that channel. A difference of one in the
displayed number represents a difference of approximately 1dB in the
received signal power. At the same time, a bar indicator to the right
gives a rough visual indication of signal strength.
There is also a slider control to adjust the squelch.
When squelch is active, the colour of the signal strength indicator bar
changes to red.
"

4.1.3.3

You should adjust the squelch level so that the output is squelched
(muted) when no transmission is taking place, so that you do not
hear continuous noise in the background. When the RSSI increases
above the set squelch level, the audio will be un-muted automatically.
Finally, there is an individual mute button for each SDR channel. As a
reminder, a red “Mute” indication is displayed when the channel is
muted.
An Example of Using the SDR’s
You want to listen to London Volmet on 128.6 MHz and Gatwick Radar
on 126.825 MHz, and also to two FM marine channels on 156.7 MHz
and 161.3 MHz.
You can do this because the four frequencies fall within two 8MHz
bands.
At the top of the control panel stack, you could set the centre
frequency of tuner A to 127MHz. This gives tuner A a range of
123MHz to 131MHz. Then you can set SDR 1 to 128.6 MHz AM, and
SDR 2 to 126.825 MHz AM.
Now set the centre frequency of tuner B to 160MHz. This gives tuner
B a range of 156MHz to 164MHz which spans the international marine
band. Then set SDR3 to 156.7 MHz FM, and SDR4 to 161.3 MHz FM.
The audio mixer panel is then set to enable these SDRs on the left
and/or right channel as required (see the Audio Mixer section).
Finally don’t forget to set the squelch levels for each SDR channel as
required using the slider bars.

4.1.3.4

Frequency Presets
BaseStation can store up to 100 preset frequencies for the internal
radio. These are accessed using the preset buttons which appear
below the pop-up frequency setting keypad, whenever it is adjacent
to an SDR channel.
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Figure 43: Preset Buttons

To listen to a preset frequency, simply click on the required preset
button. Preset buttons with a frequency stored are shown in green,
unused presets are shown greyed out. The presets are displayed in
banks of 10, and you can switch between banks using the smaller
green buttons labelled 0 to 9.
The display on the SDR channel changes to show the preset
frequency and modulation type.
"

If the SDR channel goes out of range of the 8MHz bandwidth of its
associated tuner when a preset frequency is applied, then the tuner
will be adjusted to centre on the new frequency, making it a one-step
operation to tune to the selected frequency using a preset button.

!

If you selected the frequency originally from the BaseStation
frequency database, then the SDR display will also show a description
of this frequency (for example “EGLL-TWR”). You can also manually
edit this description by using the “Set Name” button on the pop-up
keypad, before storing the frequency as a preset.
To store a frequency you are tuned to on the SDR, click on the green
M button and then the desired preset button: P00, P01 etc. Unused
presets are shown in brown and used presets are shown greyed out
after you click on M.
To clear a preset, click the green C button followed by the preset
button.

4.1.4

Using the Audio Mixer
The Audio Mixer window is launched from the SDR menu.

!

You can also use the keyboard shortcut Ctrl-Alt-M.
The window has two comprehensive audio mixer panels. The upper
panel controls the SBS-3’s analog outputs (the standard 3.5 mm
stereo audio jack socket located on the rear of the SBS-3). You can
listen to this output using external speakers or headphones. This
feature is not available on the SDR Puck.
The lower panel is for the digital output stream (transmitted to your
PC or other equipment over USB or Ethernet). You can listen to this
using a media player application. Refer to the section in the
BaseStation manual on Digital Audio Streaming.
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Figure 44: Audio Mixer Controls

On the left of each mixer panel, there is an overall master gain
(volume) slider control for the output, with the topmost setting being
the maximum.
Below this are master check-box controls for the left and right output
channels. Checking a box enables the output, unchecking it mutes
the output.
To the right are controls that select which of the SDR channels are
combined to generate the audio output. If a box is checked, then that
channel’s audio is enabled.
"

You can enable the left and right channels separately, so that for
example you could listen to one SDR channel (or combination of
channels) in your left ear and another in your right ear.
You can also adjust the relative gain (volume) for each SDR using the
slider controls. For example a channel with infrequent transmissions
but a high importance might be set to the maximum level and other
channels to a slightly lower level.

4.1.4.1

Audio Streaming Indicator
BaseStation generates a digital audio stream from the built-in SDR,
for use by third-party applications. When such an application is
connected, the STREAMING indicator on the Digital Audio section of
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the mixer window appears “lit” in bright yellow. When no streaming is
taking place, it is appears in dull yellow.

4.1.5

Using The Built-In SDR Toolbar and Menus

4.1.5.1

SDR Toolbar
Pressing this button makes the SDR Control Panel appear. Pressing
it again makes it disappear.
Pressing this button brings up a menu which allows you to select
any frequency in BaseStation’s radio frequency database. If you
select a frequency from this menu then the SDR channel currently
highlighted on the control panel will be tuned into that frequency. The
control panel itself does not have to be visible to use this feature,
however.

"

If the SDR channel goes out of range of the 8MHz bandwidth of its
associated tuner, then the tuner will be adjusted to centre on the new
frequency, making it a one-step operation to tune to a frequency
using the menus.
Note: BaseStation comes with frequencies for the UK. You can add
more frequencies to the .rfq files in the RadioFrequencies
subdirectory. Details of how to do this are available on the Kinetic
forums.
Pressing this button mutes or un-mutes the sound.
Pressing this button increases the volume.
Pressing this button decreases the volume.

"

4.1.5.2

The toolbar mute and volume control buttons operate on the master
mute and gain settings of both the analog and digital channels at the
same time.
Built-in SDR Menu
The top part of the Built-in SDR menu allows you to turn the currently
selected tuner on and off or select AM or FM demodulation on the
currently highlighted SDR channel.
The remaining menu items are equivalent to the items in the radio
toolbar above.

4.1.5.3

Local Frequencies Right-Click Popup
You can right-click anywhere on the radar display and select “Local
Frequencies-Built In Radio” from the resulting pop-up menu to get a
list of the radio frequencies in use in that area. For example, clicking
somewhere between Heathrow and Elstree would produce the
following menu:
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Figure 45: The Local Frequencies submenu

The frequencies are sorted in order of the waypoints that they are
associated with.
Simply click on the desired frequency from the list to tune the
currently highlighted SDR channel to that frequency.
The built-in SDR channels and external radio can each be tuned to
separate frequencies for maximum flexibility.

4.1.6

Receiving ACARS messages
The SBS-3 or SDR Puck’s built-In SDR can be used to receive
messages sent by aircraft using the Aircraft Communications
Addressing and Reporting System (ACARS). These are text messages
containing operational information about the aircraft, and are sent
over certain VHF air-band channels. Each of the SDR channels can be
used to decode a different ACARS channel simultaneously, allowing
up to 6 frequencies to be monitored.
To decode ACARS messages, Set one of the two tuners to 133.0 MHz,
as ACARS channels are in the upper part of the VHF air band.
Then tune the required SDR channels to your local ACARS
frequencies. The frequencies used vary throughout the world but the
following frequencies are currently used in Europe:
131.525 MHz

131.725 MHz

131.825 MHz

136.750 MHz
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Please ensure that the SDR channels to be used for ACARS are set to
AM demodulation. Please also note that the squelch level should be
set to zero and the SDR channel itself should not be muted (although
the audio output can be turned off for the channel on the mixer panel
as required).
4.1.6.1

The ACARS Message Window
BaseStation will display any ACARS messages received in a special
window which is displayed using the Built-in SDR - ACARS Window
menu item.

!

You can also use the keyboard shortcut Ctrl-Alt-A.

Figure 46: The ACARS Message Window

The text and background colours on the window can be customised
using the ACARS tab in the Settings - Display Settings menu. You can
also choose whether to keep the window on top, and in which
direction the messages scroll within the window.

Figure 47: The ACARS Display Settings

!

The columns on the ACARS Message Window can be resized by
dragging the heading separator bars. The column sizes and window
position are saved when BaseStation is shut down.
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For each ACARS message, the following columns are displayed:
Date
The date that the message was received
Time
The time that the message was received
Frequency
Indicates which ACARS channel the message was received on
Mode
A single character indicating which ACARS mode is being used.
Registration
The registration mark of the aircraft that sent the message.
Message Type
A two-character code that identifies the type of ACARS message.
Block ID
A single character from 0 to 9 which is incremented for each new
message. This allows repeat transmissions of the same message to
be identified.
Sequence Num
Each new message has a different sequence number assigned to it.
This also allows repeat transmissions of the same message to be
identified.
Flight Num
The flight number of the aircraft that sent the message.
Message Text
The actual text of the message, if any. The format and content of this
text will depend on the message type, and also on the airline and
aircraft type that transmitted it. Many of the messages are generated
automatically by the aircraft’s computer systems, with information
such as the aircraft’s position or the status of its equipment, while
others messages contain text sent directly by the crew.
"

4.1.6.2

Only those ACARS messages which pass a type of error check known
as a CRC check are displayed. This reduces the possibility of
displaying incorrectly decoded messages due to reception errors.
ACARS Message Log Files
BaseStation can be configured to write the ACARS messages to CSV
format log files. This feature is enabled from the ACARS tab in the
Settings - Display Settings menu. You can select the file name and
path for the log files - by default they are put into a folder named
ACARS under the BaseStation folder.
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You can also choose the duration of each log file in minutes. The
default is one log file per day (1440 minutes). The date and time of
the start of the log period will be added automatically to the file
name.
While BaseStation is writing a log file, other applications are
permitted to open the file for reading only.
4.1.6.3

ACARS Data Output
Other applications can receive ACARS data from BaseStation over the
network by opening a TCP connection on port 30008.

4.1.7

Receiving AIS messages
SDR channel 6 of the SBS-3 or SDR Puck Built-In Radio can be used
to receive messages sent by ships and other marine stations using
the Automatic Identification System (AIS). These messages can be
used by a third party application such as ShipPlotter to display the
positions of the ships.
To use this feature, SDR channel 6 should be set to FM and tuned to
161.975 MHz. This will allow both AIS channels (A and B) to be
decoded. Please note that the squelch level should be set to zero and
the SDR channel itself should not be muted (although the audio
output can be turned off for the channel on the mixer panel as
required).
If stand-alone operation of an SBS-3 is required, the radio settings
can be saved in the SBS-3’s non-volatile memory using the Built-In
Radio tab of the Non-volatile Memory Settings menu option in
BaseStation. The SBS-3 radio will then be initialised on power-up
without the need to run BaseStation.
The AIS data is output over Ethernet in NMEA format when a TCP
socket is opened to the NMEA port on the SBS-3. The default port
number is 30007 but this can be changed using the Ethernet tab of
the Non-volatile Memory Settings menu option in BaseStation.

4.1.8

Using a Frequency Converter
The SBS-3 or SDR Puck may be used with an external frequency
converter between the antenna and the SBS-3, for example an upconverter allowing it to receive HF transmissions. In this case it is
desirable for a frequency offset to be added to the tuner and SDR
channel frequencies selected using the control panel.
This feature is enabled by checking the Frequency Converter box that
appears under the pop-up tuning keyboard whenever it is next to the
Tuner A and B panels. Checking this box allows the offset in MHz to
be entered by clicking the Set button next to it. For example you
should enter 125.0 if the external frequency converter up-shifts by
125 MHz.
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If the frequency converter is to be used to tune below a certain
frequency only, then you can also set this threshold in MHz. The
threshold can be set to 0.0 if not used.
Whenever the frequency offset is applied, the tuner centre frequency
and SDR channel frequency are displayed in yellow instead of green.

Figure 48: The SDR Control Panel used with a frequency converter

4.1.9

Outputting I and Q Data from the SDR
The SBS-3 and SDR Puck are able to output in-phase and quadrature
(I and Q) data from SDR channel 1, for use with a third party
application such as SDR Sharp, which provides frequency-domain
displays of the radio data from the SDR channel. The sample rate of
the I and Q data is 192k samples per second, allowing a bandwidth of
approximately 180 kHz to be displayed (after filtering), 90 kHz either
side of the channel centre frequency.
"

To use this feature on the SBS-3, you must connect to the
SBS-3 using Ethernet rather than the USB port. This is
because the required data rate is higher than that supported
by the SBS-3’s USB port.

"

The USB port on the SDR Puck has a higher data rate and
can be used to output I and Q data.

"

While I and Q data is being output, SDR channel 1 cannot
be used for other functions and Wideband FM demodulation
cannot be performed. However channels 2 to 6 can be used
for other functions as normal.

BaseStation can pass on the I and Q data to a TCP network port for
the third party application to connect to, while simultaneously
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allowing other features of BaseStation such as the aircraft displays to
be used. To turn on the feature, use the Built-in SDR - I+Q Enable
menu item.

Figure 49: Enabling the I and Q Output

While in I and Q output mode, Tuner B (on the SBS-3) and SDR
channels 2-6 can be controlled from BaseStation as normal, however
Tuner A and SDR channel 1 are controlled by the SDR Sharp or other
third party application. To reflect this, the controls for Tuner A and
SDR channel 1 are removed from the control panel whenever this
mode is enabled:
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Figure 50: The SDR Control Panel with I and Q Enabled

When I and Q output mode is enabled, a panel appears on the status
bar to show the connection status.

Figure 51: I and Q Output Status

The status bar shows a red symbol when BaseStation is not
connected to an SBS-3 via ethernet, or to other Kinetic device that
supports output of I and Q data.
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It shows a blue symbol when BaseStation is connected to a suitable
device but no application is connected to BaseStation’s I and Q data
output port (TCP port 30009).
Finally a green symbol is shown when an application such as SDR
Sharp is connected to port 30009.
Please see also the section below on using SDR Sharp with the SBS-3
or SDR Puck.

4.1.10 Using SDR Sharp with the SBS-3 or SDR Puck
SDR Sharp is a third party SDR application that provides features
such as frequency domain displays and SSB demodulation. For more
information please visit:
www.sdrsharp.com
SDR Sharp can be used in conjunction with BaseStation when I and Q
output is enabled as described in the previous section. In this case
other functionality of BaseStation can be used concurrently with SDR
Sharp.
SDR Sharp can also be used with the SBS-3 or SDR Puck directly,
without running BaseStation.
4.1.10.1 Installing SDR Sharp
1. Download and unzip a copy of SDR Sharp (current stable revision
1000) from the SDR Sharp website:
www.sdrsharp.com/index.php/downloads
2. Copy the Kinetic interface file :
SDRSharp.kinetic.dll
and the FTDI USB driver file :
ftd2xx.dll
into the folder where you installed SDR Sharp
3. Edit the file:
SDRSharp.exe.config
using a text editor such as Notepad or Wordpad.
Locate the <frontendPlugins> section and add a line for the Kinetic
interface:
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<add key="Kinetic"
value="SDRSharp.kinetic.kineticIO,SDRSharp.kinetic" />
So that the section of the file looks something like:
<frontendPlugins>
<add key="SoftRock / Si570"
value="SDRSharp.SoftRock.SoftRockIO,SDRSharp.SoftRock" />
<add key="FUNcube Dongle Pro"
value="SDRSharp.FUNcube.FunCubeIO,SDRSharp.FUNcube" />
<add key="FUNcube Dongle Pro+"
value="SDRSharp.FUNcubeProPlus.FunCubeProPlusIO,SDRSharp.FUNcubeProPlus" /
>
<add key="Kinetic" value="SDRSharp.kinetic.kineticIO,SDRSharp.kinetic" />
</frontendPlugins>

4. Run SDRSharp.exe
5. In the drop down list at the top, select “kinetic” as the radio type:
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Figure 52: SDR Sharp Application Window

6. Press the Configure button to launch the configuration window. If
an SBS-3 is being used then Ethernet should be selected. If using
directly with the SBS-3 (without BaseStation) set the Host IP
address to be the IP address of the SBS-3. Set the Host TCP port
to be the main data output port of the SBS-3 (normally 10001). If
connecting through BaseStation, set the Host IP address to be the
IP address of the computer running BaseStation, and set the Host
TCP port to be the I and Q data output port of BaseStation
(normally 30009).
7. The Sample Bits setting should normally be set to 16. Setting it to
12 or 8 will reduce the data rate but results may be poor,
especially with 8 bits.
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8. The Frequency Correction box is an advanced setting that may be
used to compensate for systematic tuning errors due to any small
offset in the crystal oscillator frequency in the SBS-3. When this
feature is not used it should be set to 0.0
9. The Frequency Offset box adds an optional fixed offset to the
frequency sent to tune the SDR channel. This is useful when an
external frequency converter is used between the antenna and the
SDR. The frequency offset feature can be turned on or off using
the check box.

Figure 53: SDR Sharp Configuration Window for SBS-3 and Puck

10. Ensure that you click the Save button to save any settings you
have changed.
11. Press the Start button to start receiving the data
12. Adjust the center frequency to the required frequency and select
the demodulation type as required.
13. The “Correct IQ” check box should be left unchecked.
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Using the Built-In Radio on the SBS-1eR
The SBS-1eR features a built-in Air-band / VHF FM receiver with
integrated audio amplifier, as well as an external radio interface.
The external radio interface is described further in the next section.
The Built-in radio receiver covers the following frequencies :• Air-band AM :
118.00 Mhz to 137.00 Mhz with 25Khz or 8.33Khz channel
spacing.
• A UHF AM facility is available on SBS-1eR units with serial number
18000 or greater.
• VHF FM :
76.00 Mhz to 108.00 Mhz with 50Khz channel spacing.
To listen to the built in radio, you can use the audio socket on the
SBS-1eR, into which you can plug headphones or an audio cable to
link to the sound card on your PC or other audio equipment.
Alternatively you listen to the digital audio stream using a suitable
media player on your PC. See the section below on using digital audio
streaming.

4.2.1

Customising The Built-in Radio User Interface
The built-in radio user interface includes extra toolbar buttons. Both
the built-in radio and the external radio toolbar buttons can be
independently made visible via the Settings->Toolbars->Internal
Radio and Settings->Toolbars->External Radio menu options.
When the built-in radio toolbar is enabled should see the following
buttons appear on your toolbar:

Figure 54: The Internal Radio Toolbar

If the external radio interface is also enabled then both sets of
buttons will appear:

Figure 55: The Radio Toolbars With Both Radios Enabled

4.2.2

Using The Radio Interface

4.2.2.1

Radio Menu
The top part of the radio menu allows you to turn the radio on and off
and select the band.
The Preset Frequencies submenu allows you to select any frequency
in BaseStation’s radio frequency database. If you select a frequency
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then the built-in radio receiver will be tuned into that frequency.
Note: BaseStation comes with frequencies for the UK. You can add
more frequencies to the .rfq files in the RadioFrequencies
subdirectory. Details of how to do this are available on the Kinetic
forums.
The remaining menu items are equivalent to the items in the radio
toolbar below.
4.2.2.2

Radio Toolbar
Pressing this button makes the Radio Control Panel appear.
Pressing it again makes it disappear.
Pressing this button brings up a menu which allows you to select
any frequency in BaseStation’s radio frequency database.
Pressing this button mutes the sound.
Pressing this button increases the volume.
Pressing this button decreases the volume.

4.2.2.3

Radio Control Panel
The Radio Control Panel looks like this:

Figure 56: The SBS-1eR Radio Control Panel

The blue buttons on the left allow you to select which frequency mode
to use.
The Air button selects Air-band AM operation.
The FM button selects VHF FM operation.
The UHF button will be present only for SBS-1eR units manufactured
with serial number 18000 or greater. It may used to select the UHF
Air-band, AM operation.
The Off button allows you to turn the radio off. To turn the radio on
again, simply select either the Air or FM button.
The Channel Spacing buttons select between 8.33Khz and 25Khz
channel spacing in Air-band AM operation mode. In VHF FM mode,
the channel spacing is fixed at 50Khz spacing.
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The Mute button on the right-hand side of the panel allows you to
mute the volume. When the radio is muted the green SIGNAL
annunciator will turn into a red MUTE annunciator.
The Volume slider on the right-hand side of the panel allows you to
adjust the volume.
The Squelch slider on the right-hand side of the panel allows you to
adjust the squelch level in both AM and FM mode. When squelch is in
operation, the signal level bar graph will turn from green to red.
In Air-band AM mode, the squelch level is the level at which the builtin radio will automatically mute if the RSSI value falls below the
setting.
In VHF FM mode, the squelch level is the level at which the built-in
radio will automatically mute if the SNR value falls below the setting.
4.2.2.4

Frequency Selection
The numeric keypad allows you to enter a frequency manually,
clicking the Ent button when you have finished or Clr if you make a
mistake. You can also type the frequency in using the numeric keypad
of your PC, pressing the return/enter key when done.
The large knob (with red dot) allows you to adjust the frequency
relative to its current setting. Simply click on the red dot and drag it
either clockwise, or anti-clockwise. Alternatively you can step the
frequency up or down using the blue “<“ and “>” buttons just under
the frequency knob.
The “LED” display shows the current frequency. If you selected the
frequency by selecting a frequency from the BaseStation database
(as opposed to manually typing it in) then it will also show the
description of this frequency (in this case “EGLL-TWR”).

4.2.2.5

Frequency Presets
BaseStation can store up to 100 preset frequencies for the internal
radio. These are accessed using the preset buttons at the bottom left
of the control panel.
To listen to a preset frequency, simply click on the required preset
button. Preset buttons with a frequency stored are shown in green,
unused presets are shown greyed out. The presets are displayed in
banks of 10, and you can switch between banks using the smaller
green buttons labelled 0 to 9.
To store a frequency you are tuned to, click on the green M button
and then the desired preset button: P00, P01 etc. Unused presets are
shown in brown and used presets are shown greyed out after you
click on M.
To clear a preset, click the green C button followed by the preset
button.

© 2005-2013 Kinetic Avionics Limited.

This document is subject to the terms of the included EULA.

BaseStation Reference Manual

4.2.2.6

Page 86 / 108

RDS Data
The bottom lines of the LED display are used to display RDS data
from FM broadcasts, as in the example below:

Figure 57: The SBS-1eR Radio Control Panel - Broadcast FM

4.2.2.7

Audio Streaming Indicator
BaseStation generates a digital audio stream from the built-in radio,
for use by third-party applications. When such an application is
connected, the STREAMING indicator on the control panel appears
“lit” in bright yellow. When no streaming is taking place, it is appears
in dull yellow.

4.2.2.8

Local Frequencies Right-Click Popup
You can right-click anywhere on the radar display and select “Local
Frequencies-Built In Radio” from the resulting pop-up menu to get a
list of the radio frequencies in use in that area. For example, clicking
somewhere between Heathrow and Elstree would produce the
following menu:

Figure 58: The Local Frequencies submenu
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The frequencies are sorted in order of the waypoints that they are
associated with.
Simply click on the desired frequency from the list to tune the radio
to that frequency.
The built-in radio and external radio can be tuned to separate
frequencies for maximum flexibility.
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Using Digital Audio Streaming

SBS-3 SBS-1eR, SDR Puck
BaseStation supports audio streaming from the internal radio using
the standard network protocols RTSP and RTP/UDP. This stream can
be played using a suitable media player application, including VLC
and Apple QuickTime. A free version of VLC can be downloaded from
www.videolan.org/vlc
"

The media player used must support 16-bit linear PCM delivered over
RTP/UDP.

"

There will be a delay in the audio due to the streaming.
To play the stream using RTSP on the local machine, open the
following URL in the media player (On VLC this can be done from the
File > Open Network menu):
rtsp://127.0.0.1

!

4.3.1

If the media player is on a different machine from BaseStation, then
substitute the network address of the machine running BaseStation
instead of 127.0.0.1

Advanced Settings for Audio Streaming
There is also an audio settings tab in the Hardware Settings menu for
“advanced” users:

Figure 59: The Hardware Settings menu - Audio Tab

Under RTSP Streaming, the RTSP Port setting allows BaseStation’s
RTSP server port to be changed from the default (in case you are
running another streaming service from your PC). The Default UDP
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Port setting can be used to change the UDP port that the streaming
will be offered on by default to the media player. Note that the media
player may negotiate a different port regardless of this setting.
RTP/UDP Streaming. BaseStation also allows a targeted RTP over
UDP stream to be set up without using RTSP if required, by entering a
destination network address and port. Setting a non-blank address
will cause the UDP stream to be sent (and the Streaming indicator on
the control panel to illuminate). The receiving player will need to be
configured to expect 16-bit, 16000Hz single-channel linear PCM. On
VLC or QuickTime this can be done for example by opening an .sdp
file containing the following text (where UDP port number is 1234) :
v=0
o=BaseStation 12345 12345 IN IP4 127.0.0.1
s=BaseStationAudio
t=0 0
m=audio 1234 RTP/AVP 98
a=rcvonly
a=rtpmap:98 L16/16000/1
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4.4

External Radio Interface

4.4.1

Enabling The External Radio Interface
The radio interface supports multiple models of radio through the use
of a separate BaseStation Interface Unit (.biu) file for each model or
range.
To configure the interface, launch the Hardware Settings dialog box
by selecting the Settings > Hardware Settings menu item, and then
select the correct .biu file for your model of radio. If you are unsure
which .biu file is appropriate, then contact your dealer for advice.
You should also be sure to select the appropriate method of
connection (either your PC’s serial port or the SBS unit’s serial port).
Once you have done this and clicked on OK, the Radio menu will
appear in the top-level menu bar.

4.4.2

Customising The External Radio User Interface
The radio user interface includes extra toolbar buttons that are not
initially activated. To activate them, click on the Settings > Toolbars
> Radio menu option.
You should then see the following buttons appear on your toolbar:

Figure 60: The External Radio Toolbar

4.4.3
"

4.4.3.1

Using The External Radio Interface
You will not necessarily have access to all functions in the radio
interface, as only those functions that are supported by your model of
radio are implemented. For example, if your radio does not support
the setting of volume from a PC, then all volume controls will be
greyed out.
Radio Menu
The first few items on the radio menu allow you to turn the radio on
and off and reset it.
The Preset Frequencies submenu allows you to select any frequency
in BaseStation’s radio frequency database. If you select a frequency
then your scanner will be tuned into that frequency. Note that
BaseStation comes with frequencies for the UK. You can add more
frequencies to the .rfq files in the RadioFrequencies subdirectory.
Details of how to do this are available on the Kinetic forums.
The remaining menu items are equivalent to the items in the radio
toolbar below.
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Radio Toolbar
Pressing this button makes the Radio Control Panel appear.
Pressing it again makes it disappear.
Pressing this button brings up a menu which allows you to select
any frequency in the BaseStation radio frequency database.
Pressing this button mutes the sound.
Pressing this button increases the volume.
Pressing this button decreases the volume.

4.4.3.3

Radio Control Panel
The Radio Control Panel looks like this:

Figure 61: The External Radio Control Panel

The grey buttons on the left allow you to select which frequency
mode to use.
The On button allows you to turn the radio on.
The numeric keypad allows you to enter a frequency manually,
clicking the ent button when you have finished or Clr if you make a
mistake. You can also type the frequency in using the numeric keypad
of your PC, pressing the enter key when done.
"

Although BaseStation remembers the frequency as kHz (as in the
above example), you can enter them as MHz (i.e. you could type in
“118.5” in order to select 118500 khz – BaseStation will simply
convert it).
The large knob (with red dot) allows you to adjust the frequency
relative to its current setting. Simply click on the red dot and drag it
either clockwise, or anti-clockwise.
The blue left and right buttons allow you to make minor adjustments
to the frequency.
Finally, the slide on the right-hand side of the panel allows you to
adjust the volume.
The “LED” display shows the current frequency and volume. If you
selected the frequency by selecting a frequency from the BaseStation
database (as opposed to manually typing it in) then it will also show
the description of this frequency, in this case “EGLL-TWR”.
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Local Frequencies Right-Click Popup
You can click anywhere on the map and select “Local FrequenciesExternal Radio” from the resulting pop-up menu to get a list of the
radio frequencies in use in that area. For example, clicking
somewhere between Heathrow and Elstree would produce the
following menu:

Figure 62: The Local Frequencies submenu

The frequencies are sorted in order of the waypoints that they are
associated with. Simply click on the desired frequency to have your
radio tuned to that frequency.

4.4.4

Connecting the SBS-3 Serial Port to an External Radio
BaseStation supports control of a suitable external radio using the
SBS-3’s RS232 interface. Pins 4 and 6 of the RJ11 interface connector
on the SBS-3 will need to be connected to the radio’s RS232 control
input.
The pin-out of the RJ11 interface connector on the rear of the SBS-3
is as follows:
Pin 1 is the rightmost pin as viewed from the rear of the SBS-3
Pin 1 : 5VDC. (Pull up resistors only. Not to be used for powering
any external equipment. )
Pin 2 : I2C Clock (Used by Kinetic for external module options)
Pin 3 : I2C Data (Used by Kinetic for external module options)
Pin 4 : RS232 Tx (Used to control external Radio receivers)
Pin 5 : RS232 Rx (Used to obtain GPS co-ordinates for BaseStation
when selected)
Pin 6 : RS232 & I2C Ground
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Configuring SBS-3 Ethernet Settings
The Ethernet settings for the SBS-3 (including its IP address and port
numbers) are stored in its internal non-volatile memory. These
settings can be inspected and changed using BaseStation.
With BaseStation connected to the SBS-3 either by USB or by
Ethernet, select the “Non-Volatile Memory Settings” option from the
“Settings” menu. The following screen should be displayed:

Figure 63: Non Volatile Memory Settings - Ethernet Tab

The IP address is set to a default value of 192.168.1.170 when the
SBS-3 unit is shipped. You may need to change this if your PC’s LAN
uses an address range other than 192.168.1.xxx.
!

If you change the IP address on the SBS-3 box, you should also
change the BaseStation settings for Ethernet under “Settings” –
“Hardware” – “Network”, so that BaseStation can reconnect to the
SBS-3.
The Subnet Mask setting depends on the address size of the local
network. Typically, for 192.168.x.x networks, it is normally set to
255.255.255.0.
The Gateway address is normally set to the IP address of your local
router.
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The Speed setting sets the speed of the Ethernet interface on the
SBS-3. It can be set either to 10 M bit/sec or to 100 M bit/sec. This
setting is ignored if Auto Negotiation is turned on.
The Full Duplex checkbox sets Full Duplex mode for the Ethernet
interface (the default). This setting is ignored if Auto Negotiation is
turned on.
The Auto Negotiate checkbox turns on negotiation of connection
speed etc. between the SBS-3 Ethernet port and the device it is
connected to (e.g. PC, router or Ethernet switch). Auto negotiation is
on by default. It can be turned off where there are specific problems
with this. In this case the Speed and Duplex mode should be selected
manually.
The Main Connection panel is used to configure the way that
BaseStation or other application communicates with the SBS-3 over
the network. Normally the SBS-3 is configured as a server, and the
Port value sets the TCP port number used by BaseStation or other
application to connect to and receive data from the SBS-3. The
default port number used by the SBS-3 and BaseStation is 10001.
You may need to change the port number to another value to be able
to work with a particular application.
!

If you change the Main Port setting on the SBS-3 box, you should
also change the port number in the BaseStation settings under
“Settings” – Hardware – Network, so that BaseStation can reconnect
to the SBS-3.
The NMEA Connection panel is used for specifying a separate port
for output of AIS marine data in NMEA format.
The SBS-3 can also connect as a TCP/IP client to a third party
application, instead of acting as a TCP/IP server. Firmware version
L_0202_0000_0118_SBS3 or later is required for this. In this mode
you need to enter the Remote Server IP Address and Remote
Port for the SBS-3 to connect to. The SBS-3 will repeatedly try to
connect, waiting for the specified re-try interval between attempts.
The connection mode can be configured separately for the main data
connection and the NMEA port. If you set the client connection mode
for the main port then BaseStation will no longer be able to connect
to the SBS-3 using Ethernet. You will have to connect via USB in
order to change the settings back to normal operation (server mode).
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6

Stand-Alone Operation of the SBS-3

6.1

Stand-Alone Data Feed
The SBS-3 can be used without BaseStation to feed data to a third
party application. The application can connect via Ethernet to the
main data port of the SBS-3 instead of BaseStation. The data on this
port contains raw ADS-B and other Mode-S messages, and optionally
Mode A/C data. Applications can also control the SDR and other
features of the SBS-3 through this port using the Kinetic API.
A document describing the data format and API can be obtained from
the Kinetic Avionics website: www.kinetic.co.uk
Note: this feature is not currently available on the SBS-1 family.
BaseStation can be used to configure the SBS-3 for stand-alone use.
This is done using the “Non-Volatile Memory Settings” option from
the “Settings” menu .
If required, the main port number can be changed from the default of
10001, using the Ethernet Settings tab.
The Stand-Alone Data tab is used to enable certain features of the
data to be output. These settings will be retained when the box is
powered up without BaseStation.

"

These settings apply only to subsequent operation without
BaseStation. When you run BaseStation, these settings are ignored.
To control the settings when used with BaseStation, use the SettingsData Settings menu.

!

When the SBS-3 is connected to BaseStation, the main data port is in
use by BaseStation, and does not support a second connection. Third
party applications can however still connect via Ethernet to port
30006 on BaseStation to obtain the raw data. Other applications may
connect to port 30003 on BaseStation to obtain decoded positions
and other data for aircraft. This format of this data can also be
obtained via the Kinetic Avionics website.
In stand-alone mode, third party applications can also receive AIS
marine data by connecting via Ethernet to the NMEA data port of the
SBS-3. This is on TCP port 30007 by default, although this port
number can also be changed under the Ethernet Settings tab of the
“Settings - Non-Volatile Memory Settings” menu.
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Figure 64: Non Volatile Memory Settings - Stand Alone Data Tab

Enable Mode-S air-air replies:
Enables output of Mode-S DF 0 and DF 16 messages.
Enable other Mode S messages:
Enables other Mode S messages including DF 11 messages with a
nonzero PI field.
Enable Mode A/C replies:
Enables output of Mode A and C data.
Enable Digital Audio Packets:
Outputs RAW digital audio data (16 bit, 16k samples per second,
mono or stereo).
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Stand-Alone Operation of the SDRs
On the Built-in Radio tab on the SBS-3 Non Volatile Memory settings
screen, a button allows all of the SDR settings (including the selected
frequencies and mixer settings) to be written to the SBS-3’s nonvolatile memory so that they will be used on power up, without
BaseStation.
A second button allows the settings in the Non Volatile memory to be
returned to their default state (i.e. radios will be left powered down
when the SBS-3 is powered up stand-alone).

Figure 65: Non Volatile Memory Settings - Built-in Radio Tab
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7

BaseStation Reporter

7.1

Introduction
The BaseStation Reporter is the companion program to BaseStation.
It allows you to browse the historical data that BaseStation saves into
the database.

7.2

Using BaseStation Reporter

7.2.1

Main Screen

7.2.1.1

Aircraft Tab
The aircraft tab shows the aircraft in the database in the top pane,
with the flights made by the selected aircraft in the bottom pane.

Figure 66: Reporter's main screen, open on the Aircraft tab

The grid can easily be customised. To sort on a column, click on it. To
change the sort order to descending, click on it again.
!

You can also set the sort order and direction using the pop-down lists
on the aircraft control strip (the ones just to the left of the Filter
button).
To change the order of the columns, simply click on a column
heading, and drag it to where you want it to be. The Refresh buttons
cause the application to re-read its data from the database.

"

You would only need to do that if you want to see aircraft and flights
that BaseStation has since written into the database.
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To search for a particular record in the aircraft list, first set the sort
order of the aircraft grid to the field you want to search on, and then
start typing the phrase you are looking for into the edit box next to
the binoculars icon. After you type each letter, the grid will jump to
the first aircraft that matches that phrase. (i.e. If you set to sort on
manufacturer and then type in “Bo” it might jump to the first aircraft
with a value of “Boeing”). If you type a letter such that the phrase
now doesn’t match an aircraft, the edit box will turn red.
The Filter button allows you to set a filter so that only aircraft
matching certain criteria are shown in the aircraft. Upon clicking on it,
the following dialog box will appear:

Figure 67: The Set Aircraft Filter dialog box

To set a filter, select the “Show only those records where” radio
button, and then select the desired filter in the lower boxes.
"

The filter will be displayed in the status strip under the grid, and will
stay active until you cancel it using the Set Aircraft Filter dialog (by
selecting back to “Show all records”).
The Edit button allows you to edit the details of the selected aircraft.
Upon clicking on it, the aircraft details will appear in a dialog box:

Figure 68: The Edit Aircraft dialog
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To update the values for the aircraft, simply enter in the details and
then click on OK. To help you keep track of which values you have
edited, edit boxes turn red once changed.
7.2.1.2

Sessions Tab
The sessions tab shows the sessions in the database in the top pane,
with the flights made during the selected session in the bottom pane.

!

A session is basically the period from when you ran BaseStation to
when you shut it down. Each time you do this it counts as one
session.

Figure 69: Reporter's main screen, open on the Sessions tab

The controls on the sessions tab work in exactly the same way as on
the aircraft tab. In particular, you can search and filter the Flights grid
in the same was as you can the Aircraft tab’s Aircraft grid.

7.2.2

Menus

7.2.2.1

File
Export Database: The options in this submenu allow you to export
specific tables within the database to .csv files, which can be
imported by spreadsheet or database applications.
Export Grid: The options in the submenu allow you to export the
four grids displayed on the main window to .csv files.
Backup Database: This menu option produces a BaseStation backup
file (.bbk) that contains all of the data in the database.
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Restore Database: This menu option allows the user to restore a
previously backed up set of data (.bbk file).
#
7.2.2.2

If you restore a .bbk file, all of the data that is currently in your
database will be erased.
Edit
Copy: The options in the submenu allow you to copy the four grids
displayed on the main window to the clipboard.

7.2.2.3

Reports
Aircraft Report: This menu option produces a report (that can be
printed, previewed, or saved to .csv) of all the aircraft in the
database.
Flights Report: This menu option produces a report (that can be
printed, previewed, or saved to .csv) of all the flights that were
tracked for a certain time period.

!

7.2.2.4

The initial from and to times that appear in the Flights Report dialog
are taken from the session that is currently selected in the Sessions
tab. (i.e. The default is to produce a report showing all the flights that
were made during the current session).
Tools
Pack Database: This menu option removes unused space from the
database file to reduce its size.

#
7.2.2.5

This option must not be invoked while BaseStation (or any other
application that uses the BaseStation database) is running.
Settings
Show Status Bar: This menu option toggles the status bar on and
off.
Allow Direct Aircraft Editing: Setting this menu option (i.e. clicking
on it so that a tick appears) allows you to edit the values in the
aircraft grid simply by clicking on a cell).

#

This setting should be used with caution since, when enabled, it is
easy to inadvertently alter data without realising.
Set Grid Request Limits: This menu option brings up a dialog that
allows you to select how many records can be shown in each of the
four grids. If your database grows beyond this amount, then the
status area under each grid will show you which portion of the table
you are currently looking at, and will have controls allowing you to
move through the data.
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BaseStation Logger
BaseStation Logger is a simple program that, when run, connects to
BaseStation and writes out log files containing all the messages that
are being received as well as other bits of information. These files,
which are in CSV format, can then be analysed by spreadsheets such
as Excel, or by custom applications.
A detailed description of the format of these log files is beyond the
scope of this manual. Those requiring more details should visit the
Development forum on the SBS web-forums.
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EULA (End User Licence Agreement)

Please read this EULA carefully, as it sets out the terms and conditions upon which we
license our Software for use.
By clicking “I Agree” in the Licence Agreement Dialog Box when you first install the
Software, you agree to be bound by the terms and conditions of this EULA. You further
agree that your employees / any person you authorise to use the Software will also be
bound by the terms and conditions of this EULA. If you do not agree to this EULA, you must
click “Cancel” in the Licence Agreement Dialog Box during the installation process.
If you do not agree to this EULA, you must not use the software for any purpose
whatsoever.
1.

Definitions and interpretation

1.1

In this EULA:
“Computer” means a desktop, notebook, netbook or similar computer owned by
and in the control of the Licensee;
“Documentation” means the documentation concerning the Software supplied by
the Licensor or by the Software supplier to the Licensee with the Software;
“Effective Date” means the date when the Licensee agrees to the terms and
conditions of this EULA, as detailed in the preamble to this EULA;
“EULA” means this end user licence agreement (including the preamble), and any
amendments to it from time to time;
“Force Majeure Event” means an event, or a series of related events, that is
outside the reasonable control of the party affected (including power failures,
industrial disputes affecting any third party, changes to the law, disasters,
explosions, fires, floods, riots, terrorist attacks and wars);
“Intellectual Property Rights” means all intellectual property rights wherever in
the world, whether registered or unregistered, including any application or right of
application for such rights (and the “intellectual property rights” referred to above
include copyright and related rights, database rights, confidential information, trade
secrets, know-how, business names, trade names, trade marks, service marks,
passing off rights, unfair competition rights, patents, petty patents, utility models,
semi-conductor topography rights and rights in designs);
“Licensee” means the licensee of the Software under this EULA;
“Licensor” means Kinetic Avionics Limited, a limited company incorporated in
England and Wales having its registered office at Palladium House, Argyll Street,
London W1;
“Software” means the BaseStation application including following the application of
any Upgrade; and
“Upgrade” an upgrade, update, enhancement, improvement or patch to the
Software supplied by the Licensor.
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In this EULA, a reference to a statute or statutory provision includes a reference to:
(a)

that statute or statutory provision as modified, consolidated and/or reenacted from time to time; and

(b)

any subordinate legislation made under that statute or statutory provision.

1.3

The Clause headings do not affect the interpretation of this EULA.

1.4

The ejusdem generis rule is not intended to be used in the interpretation of this
EULA.

2.

Term of EULA
This EULA will come into force on the Effective Date and will continue in force
indefinitely, unless and until terminated in accordance with Clause 9.

3.

Licence

3.1

The Licensee may only use the Software and Documentation for the Licensee's
business / internal business / own private and non-commercial purposes and in
accordance with the provisions of this Clause 3.

3.2

Subject to the Licensee's compliance with Clause 3.4 and the other provisions of this
EULA, the Licensor grants to the Licensee a non-exclusive non-transferable licence
to:
(a)

download the Software and Documentation;

(b)

install the Software and Documentation;

(c)

use the Software in accordance with the Documentation; and

(d)

use the Documentation,

anywhere in the world.
3.3

Subject to the Licensee's compliance with Clause 3.4 and the other provisions of this
EULA, the Licensor further grants to the Licensee the rights to:
(a)
(b)

print the Documentation; and
make a back-up copy of the Software and Documentation,

in each case anywhere in the world.
3.4

The Licensee must not:
(a)

copy or reproduce the Software or Documentation or any part of the
Software or Documentation other than in accordance with the licence granted
in this Clause 3;

(b)

sell, resell, rent, lease, loan, supply, distribute, redistribute, publish or republish the Software or Documentation or any part of the Software or
Documentation;

(c)

modify, alter, adapt, translate or edit, or create derivative works of, the
Software or Documentation or any part of the Software or Documentation;
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(d)

reverse engineer, decompile, disassemble the Software or Documentation or
any part of the Software or Documentation;

(e)

use the Software or Documentation with any equipment emulating
Kinetic Avionics Limited equipment. The Software is only licensed for
use with equipment listed on the splash screen at each and every run
time of the Software;

(f)

use the Software other than in accordance with the Documentation; or

(g)

circumvent or remove or attempt to circumvent or remove the technological
measures applied to the Software and Documentation for the purposes of
preventing unauthorised use,

providing that nothing in this Clause 3.4 will prohibit or restrict the Licensee or any
other person from doing any act expressly permitted by applicable law (including
any act expressly permitted by Section 296A of the Copyright, Designs and Patents
Act 1988).
3.5

All Intellectual Property Rights in the Software and Documentation are and will
remain, as between the parties, the property of the Licensor.

3.6

The Licensee must provide to the Licensor, or procure for the Licensee, upon
reasonable notice and during normal business hours, reasonable access to:
(a)

any Computers and/or media upon which the Software and/or Documentation
is / are stored, installed or used; and

(b)

any premises at which any such Computer and/or media is situated from
time to time,

for the purpose of the investigating whether the Licensee is complying with the
terms of this EULA.
4.

Other Users
The Licensee must not permit any other person to use the Software or
Documentation or to exercise any of the other rights granted by the Licensee to the
Licensor in this EULA.

4.1

The Licensee may permit any employee of the Licensee to exercise the rights
granted by the Licensor to the Licensee under Clause 3.2(c) and (d), subject always
to the restrictions set out in Clause 3.
The Licensee may permit any person living permanently at the property where the
Computer is habitually situated to exercise the rights granted by the Licensor to the
Licensee under Clause 3.2(c) and (d), subject always to the restrictions set out in
Clause 3.

4.2

The Licensee must ensure that any person using the Software and/or
Documentation in accordance with Clause 4.1 is made aware of, and agrees to, the
terms of this EULA.

5.

Upgrades

5.1

The Licensee may apply to the Software each Upgrade released by the Licensor and
provided / made available by the Licensor to the Licensee from time to time.

5.2

The Licensor will have no obligation to provide support for the Software or repair or
replace the Software under Clause 7.2(d) in relation to any version of the Software
that does not incorporate the most recent Upgrade to the Software.
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6.

Support

6.1

The Licensor may optionally choose to provide to the Licensee telephone support
between the hours of 10.00 and 16:00 (London time) for the purpose of resolving
issues with the Software raised by the Licensee acting reasonably.

6.2

The Licensee acknowledges that:
(a)

the Licensor’s obligation under Clause 6.1 is subject to such limits (as to time
spent in relation to an issue and in relation to the Licensee in aggregate) as
the Licensor may determine from time to time;

(b)

the Licensor’s sole obligation under Clause 6.1 is to make reasonable
endeavours to resolve issues raised by the Licensee;

(c)

the Licensor does not warrant or represent that issues raised will be solved
by means of the support services; and

(d)

the Licensor will not provide any on-site support under this EULA.

6.3

The Licensor may subcontract any of its obligations under this Clause 6 to any third
party.

7.

Limited warranties

7.1

The Licensee warrants to the Licensor that it has the legal right and authority to
enter into and perform its obligations under this EULA.

7.2

The Licensor warrants to the Licensee:

7.3

(a)

that it has the legal right and authority to enter into and perform its
obligations under this EULA;

(b)

that the use of the Software by the Licensee in accordance with the terms of
this EULA will not infringe the UK Intellectual Property Rights of any third
party;

The Licensee acknowledges that:
(a)
(b)

the Software may not be error-free and that errors in the software will not
constitute a breach of this EULA;
the Software has not been developed to meet specific requirements of the
Licensee, and accordingly the Licensee will be responsible for ensuring that
the Software is suitable to meet the Licensee's requirements.

7.4

All of the parties' liabilities and obligations in respect of the subject matter of this
EULA are expressly set out herein. To the maximum extent permitted by applicable
law, no other terms concerning the subject matter of this EULA will be implied into
this EULA or any related contract.

8.

Limitations and exclusions of liability

8.1

Nothing in the EULA will:
(a)

limit or exclude the liability of a party for death or personal injury resulting
from negligence;

(b)

limit or exclude the liability of a party for fraud or fraudulent
misrepresentation by that party;
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(c)

limit any liability of a party in any way that is not permitted under applicable
law; or

(d)

exclude any liability of a party that may not be excluded under applicable
law,

and, if you are a consumer, any statutory rights which you have, which cannot be
excluded or limited, will not be affected by the EULA.
8.2

The limitations and exclusions of liability set out in this Clause 8 and elsewhere in
the EULA:
(a)

are subject to Clause 8.1; and

(b)

govern all liabilities arising under the EULA or in relation to the subject
matter of the EULA, including liabilities arising in contract, in tort (including
negligence) and for breach of statutory duty.

8.3

The Licensor will not be liable to the Licensee for any losses arising out of a Force
Majeure Event.

8.4

The Licensor will not be liable to the Licensee in respect of any business losses, such
as loss of or damage to profits, income, revenue, use, production, anticipated
savings, business, contracts, commercial opportunities or goodwill.

8.5

The Licensor will not be liable to the Licensee in respect of any loss or corruption of
any data, database or software.

8.6

The Licensor will not be liable to the Licensee in respect of any special, indirect or
consequential loss or damage.

9.

Termination
This EULA will terminate immediately and automatically if:
(a)

the Licensee or any employee of the Licensee or person authorised by the
Licensee to use the Software and/or Documentation breaches any provision
of this EULA;

(b)

the Licensee: (i) is dissolved; (ii) ceases to conduct all (or substantially all) of
its business; (iii) is or becomes unable to pay its debts as they fall due; (iv)
is or becomes insolvent or is declared insolvent; or (v) convenes a meeting
or makes or proposes to make any arrangement or composition with its
creditors;

(c)

an administrator, administrative receiver, liquidator, receiver, trustee,
manager or similar is appointed over any of the assets of the Licensee;

(d)

an order is made for the winding up of the Licensee, or the Licensee passes a
resolution for its winding up; or

(e)

(where the Licensee is an individual) the Licensee dies, or as a result of
illness or incapacity becomes incapable of managing his or her own affairs, or
is the subject of a bankruptcy petition or order.

10.

Effects of termination

10.1

Upon termination all the provisions of this EULA will cease to have effect, save that
the following provisions will survive and continue to have effect (in accordance with
their terms or otherwise indefinitely): Clauses 1, 8 and 11.
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10.2

Termination of this EULA will not affect either party's accrued rights and liabilities.

11.

General

11.1

No breach of any provision of this EULA will be waived except with the express
written consent of the party not in breach.

11.2

If a Clause of this EULA is determined by any court or other competent authority to
be unlawful and/or unenforceable, the other Clauses of this EULA will continue in
effect. If any unlawful and/or unenforceable Clause would be lawful or enforceable if
part of it were deleted, that part will be deemed to be deleted, and the rest of the
Clause will continue in effect (unless that would contradict the clear intention of the
parties, in which case the entirety of the relevant Clause will be deemed to be
deleted).

11.3

The Licensor may freely assign this EULA and/or its rights and/or obligations under
this EULA without the Licensee's consent. Save as expressly provided in this EULA,
the Licensee must not assign, transfer, charge, license or otherwise dispose of or
deal in this EULA and/or any its rights and/or obligations under this EULA.

11.4

This EULA is made for the benefit of the parties, and is not intended to benefit any
third party or be enforceable by any third party.
The rights of the parties to
terminate, rescind, or agree any amendment, waiver, variation or settlement under
or relating to this EULA are not subject to the consent of any third party.

11.5

This EULA constitutes the entire agreement and understanding of the parties in
relation to the subject matter of this EULA, and supersedes all previous agreements,
arrangements and understandings between the parties relating to the subject matter
of this EULA.
Subject to Clause 8.1, each party acknowledges that no
representations or promises not expressly contained in this EULA have been made
by or on behalf of the other party.

11.6

This EULA will be governed by and construed in accordance with the laws of England
and Wales; and the courts of England will have exclusive jurisdiction to adjudicate
any dispute arising under or in connection with this EULA.
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